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Notations Used in This Guide

Safety Symbols
The projector and its manuals use graphical symbols and labels to indicate content that tells you how to use the projector safely.
Read and carefully follow the instructions that are marked with these symbols and labels to avoid injury to persons or damage to property.

Warning
This symbol indicates information that, if ignored, could possibly result in personal injury or even death.

Caution
This symbol indicates information that, if ignored, could possibly result in personal injury or physical damage due to incorrect handling.

General Information Notations

Attention
This label indicates procedures that may result in damage or injury if sufficient care is not taken.

This label indicates additional information that may be useful to know.

[Button name] Indicates the name of the buttons on the remote control or the control panel.
Example: [Esc] button

Menu/Setting name Indicates projector menu and setting names.
Example:
Select the Image menu

This label indicates links to the related pages.

s This label indicates the projector's current menu level.

g Related Links
• "Using the Manual to Search for Information" p.7
• "Getting the Latest Version of the Documents" p.8



The PDF manual allows you to search for information you are looking for by
keyword, or jump directly to specific sections using the bookmarks. You can
also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.

g Related Links
• "Searching by Keyword" p.7
• "Jumping Directly from Bookmarks" p.7
• "Printing Only the Pages You Need" p.7

Searching by Keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you
want to find in the search window, and then click Search. Hits are displayed as a
list. Click one of the displayed hits to jump to that page.

Jumping Directly from Bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in
that section. To return to the previous page, perform the following operation on
your keyboard.
• Windows: Hold down Alt, and then press ←.
• Mac OS: Hold down the command key, and then press ←.

Printing Only the Pages You Need

You can extract and print only the pages you need. Click Print in the File menu,
and then specify the pages you want to print in Pages in Pages to Print.
• To specify a series of pages, enter a hyphen between the start page and the

end page.
Example: 20-25

• To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

Using the Manual to Search for Information 7



You can get the latest version of the manuals and specifications on the Epson
Web site.
Visit epson.sn, and enter your model name.

Getting the Latest Version of the Documents 8
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Introduction to Your Projector

Refer to these sections to learn more about your projector's features and part names.

g Related Links
• "Projector Features" p.10
• "Projector Parts and Functions" p.11



This projector comes with these special features. Refer to these sections for more
details.

g Related Links
• " Realizing a Space-saving Large Screen" p.10
• " Quick and Easy Setup" p.10

Realizing a Space-saving Large Screen

You can easily install an impressive, 100 inch screen in a small space.

• 4,500 lm of high brightness realizes crisp, clean images even in bright
environments.

• The high resolution of 4K enhancement technology allows you to display
more information than when using WUXGA or Full HD.

• The projector can be carried by one person and can be easily installed by just
placing it beside a wall.

• You can project a 100 inch screen from the projector installed close to the
wall. Since the projected light is not blocked by shadows, you can make
effective use of your meeting space.

• You can install the projector in a variety of positions such as on a desk, wall,
or ceiling.

Quick and Easy Setup

• You can use the Epson Setting Assistant application on a smart phone or
tablet that has a camera function to correct distortion more easily.

g Related Links
• "Correcting Distortion in the Image Using the Wizard" p.53
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The following sections explain the projector parts and their functions.

g Related Links
• "Projector Parts - Front" p.11
• "Projector Parts - Top/Side" p.12
• "Projector Parts - Base" p.13
• "Projector Parts - Interface Ports" p.14
• "Projector Parts - Control Panel" p.15
• "Projector Parts - Remote Control" p.16

Projector Parts - Front

Name Function

A Air filter cover Open to access the air filter.

B Air filter cover latch Slide to remove the air filter cover.

C Air intake vent (air
filter)

Takes in air to cool the projector internally.

D Front cover Open to access the air filter cover.

E Remote receiver Receives signals from the remote control.

F Status indicator Indicates the projector's status.

g Related Links
• "Air Filter and Vent Maintenance" p.145
• "Remote Control Operation" p.36
• "Projector Indicator Status" p.157
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Projector Parts - Top/Side

Name Function

A Obstacle sensors Detects obstacles that are interfering with the projection
area and reduces the brightness of the light source for
safety.

B Remote receiver Receives signals from the remote control.

Name Function

C Projection window Images are projected from the lens inside the projector.

Warning
• Do not look into the projection window

while projecting.
• Do not place any objects or put your hand

near the projection window. It could cause
burns, fire, or the object to warp because this
area reaches a high temperature due to the
concentrated projection light.

D Control panel Operates the projector.

E Focus lever Adjusts the image focus.

F Side cover latch Slide to remove the side cover.

G Air exhaust vent Exhaust vent for air used to cool the projector internally.

Caution
While projecting, do not put your face or hands
near the air exhaust vent, and do not place
objects that may become warped or damaged
by heat near the vent. Hot air from the air
exhaust vent could cause burns, warping, or
accidents to occur.

H Security slot The security slot is compatible with the Microsaver
Security System manufactured by Kensington.

I Power inlet Connects the power cord to the projector.

J Side cover Open to access the interface ports, focus lever, and
control panel.

g Related Links
• "Cleaning the Obstacle Sensor" p.143
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• "Cleaning the Projection Window" p.142
• "Air Filter and Vent Maintenance" p.145
• "Projector Parts - Control Panel" p.15
• "Focusing the Image Using the Focus Lever" p.52
• "Remote Control Operation" p.36
• "Installing a Security Cable" p.96
• "Attaching and Removing the Side Cover" p.34

Projector Parts - Base

Name Function

A Front adjustable feet When the projector is setup on a surface such as a desk,
turn the feet to correct image distortion.

Caution
Remove all feet when you install the projector
on a wall or suspend it from a ceiling.

B Air intake vent (air
filter)

Takes in air to cool the projector internally.

Name Function

C Wire clamp fixing
point

When you use the optional setting plate or ceiling
mount, fix the carabiner here to attach the safety wire
and prevent the projector from falling from the wall or
ceiling.

This point is marked with a  on the projector.

D Air exhaust vent Exhaust vent for air used to cool the projector internally.

Caution
While projecting, do not put your face or hands
near the air exhaust vent, and do not place
objects that may become warped or damaged
by heat near the vent. Hot air from the air
exhaust vent could cause burns, warping, or
accidents to occur.

E Fixing points (four
points)

Use these points to attach the optional mount when
installing the projector on a wall or suspending the
projector from a ceiling.

This point is marked with a  on the projector.

F Air intake vent Takes in air to cool the projector internally.

G Rear adjustable foot When setup on a surface such as a desk, extend the foot
to adjust the position of the image.

Caution
Remove all feet when you install the projector
on a wall or suspend it from a ceiling.

H VESA mount fixing
points (four points)

Use these points to attach the commercially available
mount compatible with the VESA Mounting Interface
Standard (100 × 200 mm) when installing the projector
on a wall or suspending the projector from a ceiling.

Projector Parts and Functions 13



g Related Links
• "Air Filter and Vent Maintenance" p.145
• "Installing a Security Cable" p.96

Projector Parts - Interface Ports

Name Function

A USB-A port (USB-
A1)

Use to connect a USB memory device or digital camera
for projecting movies or images using the PC Free
feature or in Content Playback mode.
Use to connect a USB memory device to save error and
operation log files.

In this guide, USB-A1 and USB-A2
ports are collectively referred to as
the USB-A port.

B USB-B port This port is used for batch settings and firmware update.

Name Function

C USB-A ( )
port (USB-A2)

Use to connect a USB memory device or digital camera
for projecting movies or images using the PC Free
feature or in Content Playback mode.
Use to connect a USB memory device to save error and
operation log files.
Provides a connection for a commercially available
streaming media player allowing you to power it.

In this guide, USB-A1 and USB-A2
ports are collectively referred to as
the USB-A port.

D RS-232C port Use to connect an RS-232C cable to control the
projector from a computer. (This port is for control use
and should not normally be used.)

E LAN port Use to connect a LAN cable to connect to a network.

F HDMI1 port Inputs video signals from HDMI compatible video
equipment and computers.
Compatible with HDCP 2.3.

G HDMI2 (eARC/ARC)
port

Inputs video signals from HDMI compatible video
equipment and computers.
Compatible with HDCP 2.3.
Compatible with HDMI eARC/ARC.

g Related Links
• "Projector Connections" p.28
• "Installing a Security Cable" p.96
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Projector Parts - Control Panel

Name Function

A Power button [ ] Turns the projector on or off.

B [Menu] button Displays and closes the projector's menu.

C Volume buttons Adjusts the volume of any external speakers.
Selects menu items while displaying the projector's
menu.

D [Enter] button [ ] Enters the current selection and moves to the next level
while displaying the projector's menu.

E Arrow buttons Selects menu items while displaying the projector's
menu.

F [Home] button Displays and closes the Home screen.

G [Esc] button Stops the current function.
Moves back to the previous menu level while displaying
the projector's menu.

H [Source] button Changes to the next input source.

g Related Links
• "Turning On the Projector" p.38

• "Adjusting the Menu Settings" p.117
• "Home Screen" p.39
• "Selecting an Image Source" p.65
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Projector Parts - Remote Control

Name Function

A [On] button Turns the projector on.

Name Function

B [Standby] button Turns the projector off.

C [HDMI1]/[HDMI2]
button

Switches the image source between the HDMI1 and
HDMI2 (eARC/ARC) ports.

D [Information] button Displays the Information screen.

E [Light Output] button Displays the Brightness Level screen.

F Playback control
buttons

Controls playback of the connected devices that support
the HDMI CEC standard.

G [HDMI Link] button Displays the HDMI Link screen.

H [HDR] button Displays the Dynamic Range screen.

I [Color Mode] button Displays the Color Mode screen.

J Arrow buttons Selects menu items while displaying the projector's
menu.

K [Enter] button Enters the current selection and moves to the next level
while displaying the projector's menu.

L [Default] button Returns the selected setting to its default value.

M [Menu] button Displays and closes the projector's menu.

N [Memory] button Displays the Memory menu.

O [Frame Int] button Sets the strength for Frame Interpolation.

P [Sleep] button Set to On to automatically turn off the projector after an
interval of inactivity.

Q [User] button Performs settings assigned in the User Button setting in
the projector's Management menu.

R [Pattern] Displays the Test Pattern screen.

S [Fine/Fast] button Displays the Image Processing screen.

T [RGBCMY] button Adjusts the hue, saturation, and brightness for each
RGBCMY color.
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Name Function

U [Esc] button Stops the current function.
Moves back to the previous menu level while displaying
the projector's menu.

V [Image Enh] button Displays the Image Enhancement screen.

W [Aspect] button Displays the Aspect screen.

X [USB] button Switches the image source to the USB-A port.

Y [Blank] button Turns the video off temporarily to output sound only. To
turn the image back on, press this button again.

Z Illumination button When you press this button, the remote control buttons
light up for approximately 10 seconds. This is useful
when operating the remote control in the dark.

a Remote control light
emitting area

Outputs remote control signals.

g Related Links
• "Turning On the Projector" p.38
• "Projecting in Content Playback Mode" p.87
• "Adjusting the Menu Settings" p.117
• "Adjusting Image Quality (Color Mode)" p.68
• "Image Aspect Ratio" p.66
• "Resizing the Image with Digital Zoom" p.62
• "Shutting Off the Image Temporarily" p.93
• "Home Screen" p.39
• "Remote Control Operation" p.36
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Setting Up the Projector

Follow the instructions in these sections to set up your projector.

g Related Links
• "Projector Placement" p.19
• "Installing the Safety Wire" p.23
• "Projector Connections" p.28
• "Wired Network Connection" p.32
• "Attaching and Removing the Side Cover" p.34
• "Installing Batteries in the Remote Control" p.35
• "Remote Control Operation" p.36



You can install the projector on a wall or ceiling, or place it on a table to project
images.
To install the projector on a wall or mount the projector from a ceiling, you can
use an optional mount or a commercially available mount compatible with the
VESA Mounting Interface Standard (100 × 200 mm).
The projector can be installed at various angles. There is no vertical or
horizontal limit to how the projector can be installed.
Note the following points when selecting a projector location:
• Place the projector on a sturdy, level surface or install it using a compatible

mount.
• Leave plenty of space around and under the projector for ventilation, and do

not place it on top of or next to anything that could block the vents.
• Place the projector so it squarely faces the screen, not at an angle.

If you cannot install the projector squarely facing the screen, correct
any resulting keystone distortion using the projector controls. For the
best quality images, we recommend adjusting the installation position
of the projector to achieve the correct image size and shape.

• When you install the projector to a fixed location, turn on the Fixed
Installation setting in the projector's Installation menu.

You can adjust distortion and the height of the projected image using the
front adjustable feet and rear adjustable foot.
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Warning
• A special method of installation is required when suspending the projector from a

wall or ceiling. If you do not install the projector correctly, it could fall and cause
damage or injury.

• Do not use adhesives on the setting plate fixing points or other mount fixing
points to prevent the screws from loosening, or use lubricants, oils, or similar
substances on the projector; the projector case may crack causing it to fall from
its mount. This could cause serious injury to anyone under the mount and could
damage the projector.

• Failure to install the ceiling mount and projector may cause the projector to
fall. After installing the specific Epson mount that supports your projector, make
sure you secure the mount to all of the projector's ceiling mount fixing points.
Also, secure the projector and the mounts using the safety wire supplied with the
projector or an optional wire.

• Do not install the projector in a location subject to high levels of dust or humidity,
or in a location subject to smoke or steam. Otherwise, it could cause a fire
or electric shock to occur. The projector's case could also deteriorate and be
damaged causing the projector to fall from the mount.
Examples of environments that could cause the projector to fall due to case
deterioration
• Locations subject to excessive smoke or airborne oil particles, such as factories

or kitchens
• Locations containing volatile solvents or chemicals, such as factories or

laboratories
• Locations where the projector could be subjected to detergents or chemicals,

such as factories or kitchens
• Locations in which aroma oils are often used, such as relaxation rooms
• Near devices that produce excessive smoke, airborne oil particles, or foam at

events
• Locations near humidifiers

Warning
• Do not cover the projector's air intake or air exhaust vents. If the vents are

covered, the internal temperature could rise and cause a fire.
• Do not use or store the projector in locations where it will be subject to dust or

dirt. Otherwise, the quality of the projected image may decline, or the air filter
may become clogged, resulting in a malfunction or fire.

• Do not install the projector on an unstable surface or in a location beyond the
weight specifications of the projector. Otherwise, it could fall or topple causing an
accident and injury.

• When installing the projector in a high position, take measures to prevent falling
by using wires to ensure safety in an emergency, such as an earthquake, and to
prevent accidents. If it is not installed correctly, it could fall causing an accident
and injury.

• Do not install in locations where salt damage could occur, or in locations subject
to corrosive gas such as sulphuric gas from hot springs. Otherwise, corrosion
could cause the projector to fall. It could also cause the projector to malfunction.

Attention
• If you are using the projector at altitudes above 1,500 m, set the High Altitude

Mode setting to On in the projector's Installation menu to ensure the projector's
internal temperature is regulated properly.

• Try not to setup the projector in locations subject to high humidity and dust, or in
locations subject to smoke from fires or tobacco smoke.

g Related Links
• "Projector Setup and Installation Options" p.20
• "Precautions on Installation" p.21

Projector Setup and Installation Options

You can set up or install your projector in the following ways:
Front/Rear
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Front Upside Down/Rear Upside Down

Select the correct Projection option in the projector's Installation menu
according to the installation method being used. If necessary, change the Inv
Direction Button setting in the projector's Operation menu.

The default Projection setting is Front.

g Related Links
• "Changing the Projection Mode" p.46

Precautions on Installation

Attention
• If the projector is installed at an angle, it should be installed by qualified

technicians using mounting hardware designed for use with this projector.
• Install the projector appropriately to prevent it from falling down.
• Use M4 screws (up to a depth of 9 mm) to secure the projector's fixing points, or

VESA mount fixing points, to the mounting hardware at four points.
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Installation space

Attention
Be sure to leave the following amount of space around the projector so as not to
block the air exhaust and intake vents.

A 2.3 cm
B 20 cm
C 10 cm

Installation space (When installing multiple projectors side by side)

Attention
• If you are installing multiple projectors next to each other, make sure hot air from

the exhaust vent does not go into the air intake vent of another projector.

A 110 cm

• If you use a partition, you can narrow the space between the projectors.

B 20 cm
* Partition
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You can install the safety wire to prevent the projector from falling from the
ceiling.

Warning
Be sure to use the safety wire provided with the Epson ceiling mount. The safety wire
is available as an optional Safety Wire Set ELPWR01.

g Related Links
• "When Using the Ceiling Mount ELPMB22" p.23
• "When Using the Ceiling Mount ELPMB30" p.24
• "When Using the Setting Plate ELPMB75" p.25

When Using the Ceiling Mount ELPMB22

You can attach a safety wire to your projector for increased safety as shown.
Before you start, you need to remove the front adjustable feet and the rear
adjustable foot from the projector. Also, make sure you have securely attached
the ELPMB22 ceiling mount to the projector and have the following items that
are included in the safety wire set:
• Safety wire × 1
• Carabiner × 2 (Only one carabiner is used for the ELPMB22.)
• Wire clamp × 1
• Attaching screw (M4 × 10 mm) × 1

For details on installing the ELPMB22, see the Ceiling Mount ELPMB22/
ELPMB23 Instruction Manual.

a Attach the wire clamp to the carabiner, and then use the screw to fix the
wire clamp to the wire clamp fixing point ( ) on the projector.

b Loop the safety wire around the support shaft of the ceiling mount, and
attach both ends to the carabiner on the projector.
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c Tighten the carabiner lock.

When Using the Ceiling Mount ELPMB30

You can attach a safety wire to your projector for increased safety as shown.
Before you start, you need to remove the front adjustable feet and the rear
adjustable foot from the projector. Also, make sure you have securely attached
the ELPMB30 ceiling mount to the projector and have the following items that
are included in the safety wire set:
• Safety wire × 1
• Carabiner × 2 (Only one carabiner is used for the ELPMB30.)
• Wire clamp × 1
• Attaching screw (M4 × 10 mm) × 1

For details on installing the ELPMB30, see the ELPMB30 User's Guide.

a Attach the wire clamp to the carabiner, and then use the screw to fix
the wire clamp to the screw into the wire clamp fixing point ( ) on the
projector.

b Loop the safety wire through the hole in the ceiling mount, and then
attach both ends to the carabiner.
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c Tighten the carabiner lock.

When Using the Setting Plate ELPMB75

You can attach a safety wire to your projector for increased safety as shown.
Before you start, you need to remove the front adjustable feet and the rear
adjustable foot from the projector. Also, make sure you have securely attached
the ELPMB75 setting plate to the projector and have the following items that are
included in the safety wire set:
• Safety wire × 1
• Carabiner × 2
• Wire clamp × 1
• Attaching screw (M4 × 10 mm) × 1

For details on installing the ELPMB75, see the ELPMB75 User's Guide.

a Attach the wire clamp to the carabiner, and then use the screw to fix
the wire clamp to the screw into the wire clamp fixing point ( ) on the
projector.

b Loop both ends of the safety wire through the carabiner, and then tighten
the carabiner lock.
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c Pass the other carabiner through the hole in the arm of the setting plate. d Loop the safety wire through the carabiner attaching it to the setting plate.
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e Tighten the carabiner lock.
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See these sections to connect the projector to a variety of projection sources.

Attention
• Check the shape and orientation of the connectors on any cable you plan to

connect. Do not force a connector into a port if it does not fit. The device or your
projector could be damaged or could malfunction.

• Depending on the connected device and the shape of the cable, you may not be
able to attach the side cover to the projector. In that case, do not force the cover
into place. The device or your projector could be damaged or could malfunction.

See the Quick Start Guide for a list of cables supplied with your projector.
Purchase commercially available cables when necessary.

g Related Links
• "Connecting to an HDMI Video Source" p.28
• "Connecting to a Computer for HDMI Video" p.28
• "Connecting to External USB Devices" p.29
• "Connecting to a Streaming Media Player" p.30
• "Connecting to an eARC/ARC Compatible AV System or External Speakers"

p.31
• "Getting the Latest Version of the Documents" p.8

Connecting to an HDMI Video Source

If your video source has an HDMI port, you can connect it to the projector
using an HDMI cable.

Attention
Do not turn on the video source before connecting it to the projector. Doing so could
damage the projector.

• If the port on the device you connect has an unusual shape, use the
cable supplied with the device or an optional cable to connect to the
projector.

• The cable differs depending on the output signal from the connected
video devices.

• Some video devices are capable of outputting different types of signals.
See your video device manual to confirm what type of signals can be
output.

a Connect the HDMI cable to your video source's HDMI output port.

b Connect the other end to one of the projector's HDMI ports.

Connecting to a Computer for HDMI Video

If your computer has an HDMI port, you can connect it to the projector using
an HDMI cable.

a Connect the HDMI cable to your computer's HDMI output port.
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b Connect the other end to one of the projector's HDMI ports.

Connecting to External USB Devices

Follow the instructions in these sections to connect external USB devices to the
projector.

g Related Links
• "USB Device Projection" p.29
• "Connecting to a USB Device" p.29
• "Disconnecting a USB Device" p.30

USB Device Projection

You can project images and other content without using a computer or video
device by connecting any of these devices to your projector:
• USB flash drive
• Digital camera or smartphone
• USB hard drive

• Digital cameras or smartphones must be USB-mounted devices, not
TWAIN-compliant devices, and must be USB Mass Storage Class-
compliant.

• USB hard drives must meet these requirements:
• USB Mass Storage Class-compliant (not all USB Mass Storage Class

devices are supported)
• Formatted in FAT16/32
• Self-powered by their own AC power supplies (bus-powered hard

drives are not recommended)
• Avoid using hard drives with multiple partitions

You can also project playlists that contain images and movies saved on a USB
flash drive in Content Playback mode.

g Related Links
• "Projecting a PC Free Presentation" p.82
• "Projecting in Content Playback Mode" p.87

Connecting to a USB Device

You can connect your USB device to the projector's USB-A port and use it to
project images and other content.

a If your USB device came with a power adapter, plug the device into an
electrical outlet.
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b Connect the USB cable or USB flash drive to the projector's USB-A port as
shown.

Attention
• Use the USB cable supplied with or specified for use with the device.
• Do not connect a USB hub or a USB cable longer than 3 meters, or the

device may not operate correctly.

c Connect the other end to your device, if necessary.

Disconnecting a USB Device

When you have finished projecting with a connected USB device, disconnect the
device from the projector.

a Turn off and unplug the device, if necessary.

b Disconnect the USB device from the projector.

Connecting to a Streaming Media Player

You can connect your streaming media player to the projector's HDMI port. By
connecting the power supply USB cable, you can power the streaming media
player from the projector.

The connection method and operating environment for the streaming
media player vary depending on the model you are using. For details, see
the documentation supplied with your streaming media player; otherwise,
it may not operate properly.

a Connect your streaming media player to the projector's HDMI port.

b Connect the power supply USB cable to the projector's USB-A port.
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c Connect the other end to the streaming media player.

Connecting to an eARC/ARC Compatible AV System or
External Speakers

If your AV system or speakers, such as a sound bar, has an HDMI port, you can
connect them to the projector using an HDMI cable (with Ethernet) to output
audio to these devices.

• When the AV System is connected to the projector, set HDMI Link to
On.
s Signal I/O > HDMI Link > HDMI Link

• See the Supplemental A/V Support Specification for eARC/ARC audio
supported formats.

a Connect the HDMI cable to your AV system's or speakers' HDMI output
port (eARC/ARC compatible).

b Connect the other end to the projector's HDMI2 (eARC/ARC) port.

c Make any necessary settings on the connected AV system. See your
device's documentation for more information.

g Related Links
• "Getting the Latest Version of the Documents" p.8
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You can monitor and control your projector, over a network.
To perform these operations, connect the projector to your network, and then
set up your projector and computer.

g Related Links
• "Connecting to a Wired Network" p.32
• "Selecting Wired Network Settings" p.32

Connecting to a Wired Network

To connect the projector to a wired local area network (LAN), use a network
cable. To ensure proper data transmission, use a Category 5 shielded cable or
better.

a Connect one end of the network cable to your network hub, switch, or
router.

b Connect the other end of the cable to the projector's LAN port.

Selecting Wired Network Settings

Before you can use the projector on your network, you need to select network
settings on the projector.

Make sure you already connected the projector to your wired network
using the LAN port.

a Press the [Menu] button, select the Network menu, and press [Enter].

b Select Network Settings and press [Enter].

c To identify the projector over the network, select Projector Name and
enter a name up to 16 alphanumeric characters long.
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d Select the Wired LAN menu and press [Enter].

e Assign the IP settings for your network as necessary.
• If your network assigns addresses automatically, select IP Settings to set

the DHCP setting to On.
• If you must set addresses manually, select IP Settings to set the DHCP

setting to Off, and then enter the projector's IP Address, Subnet Mask,
and Gateway Address as necessary.

f To prevent the IP address from being displayed on the network
information screen, set the IP Address Display setting to Off.

g When you finish selecting settings, go back to the Network Settings
screen, select Set, and follow the on-screen instructions to save your
settings and exit the menus.

If the Web Control Password has not been set, a screen prompting
you to set a password is displayed when you save the network
settings. Follow the on-screen instructions to set the password.

g Related Links
• "Network Menu - Network Settings Menu" p.131
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You can attach the side cover to hide the attached cables from view.

a Remove the side cover from the projector.

b Pass a commercially available cable tie through the cable holder and tie
the cables together.

Caution
Do not bundle the power cord to the other cables. Otherwise, a fire may occur.

c Replace the side cover.
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The remote control uses the two AA batteries that came with the projector.

Attention
Make sure you read the Safety Instructions before handling the batteries.

Replace the batteries as soon as they run out. The remote control uses two
AA manganese or alkaline batteries.

a Remove the battery cover as shown.

b Remove the old batteries, if necessary.

Dispose of used batteries according to local regulations.

c Insert the batteries with the + and – ends facing as shown.

Warning
Check the positions of the (+) and (–) marks inside the battery holder to
ensure the batteries are inserted the correct way. If the batteries are not used
correctly, they could explode or leak causing a fire, injury, or damage to the
product.

d Replace the battery cover and press it down until it clicks into place.
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The remote control lets you control the projector from almost anywhere in the
room.
Make sure that you aim the remote control at the projector's receivers within the
distance and angles listed here.

Avoid using the remote control in conditions with bright fluorescent lights
or in direct sunlight, or the projector may not respond to commands. If
you are not going to use the remote control for a long time, remove the
batteries.
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Using Basic Projector Features

Follow the instructions in these sections to use your projector's basic features.

g Related Links
• "Turning On the Projector" p.38
• "Turning Off the Projector" p.41
• "Setting the Date and Time" p.42
• "Selecting the Language for the Projector Menus" p.45
• "Changing the Projection Mode" p.46
• "Setting the Screen Type" p.47
• "Adjusting the Image Height" p.50
• "Displaying a Test Pattern" p.51
• "Focusing the Image Using the Focus Lever" p.52
• "Image Shape" p.53
• "Resizing the Image with Digital Zoom" p.62
• "Adjusting the Image Position Using Image Shift" p.63
• "Selecting an Image Source" p.65
• "Image Aspect Ratio" p.66
• "Adjusting Image Quality (Color Mode)" p.68
• "Setting Frame Interpolation" p.70
• "Adjusting the Image Color" p.72
• "Adjusting the Image Resolution" p.75
• "Adjusting the Brightness" p.77



Turn on the computer or video equipment you want to use after you turn on the
projector.

a Remove the side cover.

b Connect the power cord to the projector's power inlet and plug it into an
electrical outlet.

Warning
Be sure to connect to ground before plugging in. When you remove the
ground connection, unplug the power cord and disconnect from ground.

The projector's power indicator turns blue. This indicates that the
projector is receiving power, but is not yet turned on (it is in standby
mode).

c Press the power button on the control panel or remote control to turn on
the projector.
The status indicator flashes blue as the projector warms up. Once the
projector is warmed up, the status indicator stops flashing and turns blue.
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• When you turn on the projector for the first time, the initial
setup wizard is displayed. Follow the instructions on the initial
setup wizard screen.

• If no Web Control Password has been set in the Network
Settings menu, the Web Control Password is displayed. Set the
password on this screen. Web Control Password is necessary to
control the networked projectors using a Web browser on the
computer.

• You can also select the Quick Startup setting in the projector's
Operation menu.

Try the following if you do not see a projected image.
• Turn on the connected computer or video device.
• Change the screen output from the computer when using a laptop computer.
• Insert a DVD or other video media, and press play (if necessary).
• Press the [Source] button on the control panel to detect the source.
• Press the button for the desired video source on the remote control.
• If the Home screen is displayed, select the source you want to project.

Warning
• Never look into the projector lens when the light source is on. This can damage

your eyes and is especially dangerous for children.
• When turning on the projector at a distance using the remote control, make sure

there is no one looking into the lens.
• If the light from the projector is blocked, the area on which the light shines

becomes hot which could cause it to melt, burn, or start a fire. Also, the lens may
get hot due to the reflected light which could cause the projector to malfunction.
To stop projection, turn off the projector.

• When the Direct Power On setting is set to On in the projector's
Operation menu, the projector turns on as soon as you plug it in. Note
that the projector also turns on automatically in cases such as recovery
from a power outage.

• If you select a specific port as the Auto Power On setting in the
projector's Operation menu, the projector turns on as soon as it detects
a signal or cable connection from that port.

g Related Links
• "Home Screen" p.39
• "Projector Feature Settings - Operation Menu" p.127

Home Screen

The Home screen feature allows you to easily select an image source and access
useful functions. You can display the Home screen by pressing the [Home]
button on the control panel. The Home screen is also displayed when you turn
on the projector and no signal is being input.
Press the arrow buttons on the control panel or remote control to select a menu
item, and then press [Enter].

Turning On the Projector 39



A Selects the source you want to project.
A check mark appears on the upper right of the current input source.
You can check a preview of the current input image for most sources as a
thumbnail (other than the USB input source in Content Playback mode).

B Lets you select the following common projector settings (settings may vary
depending on other selected settings):
• Color Mode
• Brightness Level
• Geometry Correction (Quick Corner is available.)
• Aspect
• Install Again

The Geometry Correction setting is only displayed when Fixed
Installation is set to Off and Geometry Correction is set to Quick
Corner in the projector's Installation menu.

C Displays the projector name and the projector keyword.

D Displays the current time.

The Home screen disappears after 10 minutes of inactivity.
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Turn off the projector after use.

• Turn off this product when it is not in use to prolong the life of the
projector. Light source life varies depending on the mode selected,
environmental conditions, and usage. Brightness decreases over time.

• Since the projector supports the direct shutdown feature, it can be
turned off directly using the breaker.

a Press the power button on the control panel or the [Standby] button on
the remote control.
The projector displays a shutdown confirmation screen.

b Press the power button or the [Standby] button again. (To leave it on, press
any other button.)
The light source turns off, and the status indicator turns off.

c To transport or store the projector, make sure the power indicator is blue
(but not flashing) and the status indicator is off, then unplug the power
cord.
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You can set the date and time for the projector.

a Turn on the projector.

b Press the [Menu] button on the control panel or remote control.

c Select the Management setting and press [Enter].

d Select the Date & Time setting and press [Enter].
You see this screen:

e Select the Date & Time setting and press [Enter].
You see this screen:

f Select Date, press [Enter], and use the displayed keyboard to enter today's
date.
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g Select Time, press [Enter], and use the displayed keyboard to enter the
current local time.

To set the Time Difference (UTC) as explained in step 8, enter
Coordinated Universal Time instead of the current local time.

h Select Time Difference (UTC), press [Enter], and set the time difference
from Coordinated Universal Time.

i When you are finished, select Set and press [Enter].

j To activate daylight saving time, select the Daylight Saving Time setting
and set it to On. Then select settings.

k When you are finished, select Set and press [Enter].
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l To update the time automatically through an Internet time server, select
the Internet Time setting and set it to On. Then select settings.

m When you are finished, select Set and press [Enter].

n Press [Menu] or [Esc] to exit the menus.
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If you want to view the projector's menus and messages in another language,
you can change the Language setting.

a Turn on the projector.

b Press the [Menu] button on the control panel or remote control.

c Select the Management setting and press [Enter].

d Select the Language setting and press [Enter].

e Select the language you want to use and press [Enter].

f Press [Menu] or [Esc] to exit the menus.
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Depending on how you positioned the projector, you may need to change the
projection mode so your images project correctly.
• Front lets you project from a table in front of the screen.
• Front/Upside Down flips the image over top-to-bottom to project upside-

down from a wall mount or ceiling.
• Rear flips the image horizontally to project from behind a translucent screen.
• Rear/Upside Down flips the image over top-to-bottom and horizontally to

project from a wall mount or ceiling and behind a translucent screen.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Projection and press [Enter].

e Select a projection mode and press [Enter].

f Press [Menu] or [Esc] to exit the menus.
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You can use the Screen Type setting to match the aspect ratio of the displayed
image to the screen you are using.

• You cannot change the Screen Type setting when the Content
Playback setting is set to On in the projector's Operation menu.

• If you change the Screen Type setting, the Geometry Correction
settings are initialized.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Screen Type and press [Enter].

e Select your screen's aspect ratio and press [Enter].
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f Press [Menu] to exit the menus.

You need to restart the projector. Follow the on-screen instructions.

g Adjust the aspect ratio for the projected image, if necessary.

When the Screen Type setting changes, the EDID settings are
automatically adjusted.

g Related Links
• "Adjusting the Image Position Using Screen Position" p.48

Adjusting the Image Position Using Screen Position

You can adjust the image position if there are margins between the edge of the
image and the projected screen frame.

You cannot adjust the screen position if the Screen Type setting is set to
16:9.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Screen Position, and press [Enter].
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e Use the arrow buttons on the control panel or remote control to adjust the
position of the image.

f When you are finished, press [Menu].
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If you are projecting from a table or other flat surface and the image is too high
or low, you can adjust the image height using the projector's adjustable feet.
The larger the angle of tilt, the harder it becomes to focus. Locate the projector
on a level surface so that it only needs to be tilted at a small angle.

a Turn on the projector and display an image.

b Rotate the rear feet to adjust the image height.

A Extend the rear foot

B Retract the rear foot

If the projected image is unevenly rectangular, you need to adjust the image
shape.

g Related Links
• "Image Shape" p.53
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You can display a test pattern to adjust the projected image.

Some settings may not be available while displaying a test pattern. To
adjust these settings, project an image from a connected device.

a Turn on the projector.

b Press the [Pattern] button on the remote control.

You can also display a test pattern from the projector's Installation
menu.

c Adjust the image as necessary.

d To cancel pattern display, press the [Pattern] button again.
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You can correct the focus using the focus lever.

a Turn on the projector and display an image.

b Remove the side cover.

c Move the focus lever to adjust the focus.

d Replace the side cover.

Focus the following part on the screen. Display a test pattern to adjust the
focus if necessary.
• Projecting from a table: center, and upper left and right
• Projecting from a ceiling: center, and bottom left and right
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You can project an even, rectangular image by placing the projector directly in
front of the center of the screen and keeping it level. If you place the projector at
an angle to the screen, or tilt it up or down, or off to the side, you may need to
correct the image shape.
After correction, your image is slightly smaller.
For the best quality images, we recommend adjusting the installation position of
the projector to achieve the correct image size and shape.

If you adjust the screen position using the Image Shift feature, perform
Image Shift before Geometry Correction.

g Related Links
• "Correcting Distortion in the Image Using the Wizard" p.53
• "Correcting the Image Shape with Quick Corner" p.54
• "Correcting Image Shape with Arc Correction" p.57
• "Correcting Image Shape with Point Correction" p.59

Correcting Distortion in the Image Using the Wizard

You can correct distortion in the projected image by following the on-screen
instructions from the Installation menu.

To correct distortion more easily, you can use the Epson Setting Assistant
application on a smart phone or tablet that has a camera function. Install
the application by using the QR code displayed on the projected screen.
The customer is responsible for any communication charges incurred
when downloading the app.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].
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d Select the Geometry Correction Wizard, and press [Enter].

e Follow the on-screen instructions to correct distortion in the image.

f To close the menus, press [Esc].

Correcting the Image Shape with Quick Corner

You can use the projector's Quick Corner setting to correct the shape and size
of an image that is unevenly rectangular.

If you change the Screen Type and Screen Position settings, the
adjustments are reset.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.
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c Select the Installation menu and press [Enter].

d Select Geometry Correction and press [Enter].

e Select Quick Corner and press [Enter]. Then select Yes and press [Enter]
if necessary.

You see the area selection screen.
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f Use the arrow buttons to select the area of the image you want to adjust.
Then press [Enter].

To reset the Quick Corner corrections, hold down [Esc] for about 2
seconds while the area selection screen is displayed, and then select
Yes.

g Press the arrow buttons to adjust the image shape as necessary.
To return to the area selection screen, press [Enter].

• You can also select the area by pressing the following numeric
buttons on the remote control:
• [1] selects the upper left area.
• [3] selects the upper right area.
• [7] selects the lower left area.
• [9] selects the lower right area.

• If you see this screen, you cannot adjust the shape any further in
the direction indicated by the gray triangle.

h Repeat steps 6 and 7 as needed to adjust any remaining corners.

i When you are finished, press [Esc].

The Geometry Correction setting is now set to Quick Corner in the projector's
Installation menu.
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To save the current shape of an image you have adjusted, select Save
Memory. You can save up to three image shapes in the memory.
s Installation > Geometry Correction > Memory > Save Memory

Correcting Image Shape with Arc Correction

You can use the projector's Arc Correction setting to adjust the shape of an
image projected on a curved or spherical surface.

If you change the Screen Type and Screen Position settings, the
adjustments are reset.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Geometry Correction and press [Enter].
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e Select Arc Correction and press [Enter].

You see the Arc Correction screen.

f Select Arc Correction and press [Enter].

You see the area selection screen.

g Use the arrow buttons to select the area of the image you want to adjust,
then press [Enter].

h Press the arrow buttons to adjust the image shape of the selected area as
necessary.
To return to the area selection screen, press [Enter].
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If you see this screen, you cannot adjust the shape any further in the
direction indicated by the gray triangle.

i Repeat steps 7 and 8 as needed to adjust any remaining corners.

j When you are finished, press [Esc].

• You can fine tune the corrected results. Use Quick Corner to adjust the
tilt of the image, and then use Point Correction for fine tuning. Select
Quick Corner or Point Correction on the screen in step 6.

• To save the current shape of an image you have adjusted, select Save
Memory. You can save up to three image shapes in the memory.
s Installation > Geometry Correction > Memory > Save Memory

• To reset the Arc Correction settings, hold down [Esc] for about 2
seconds while the area selection screen is displayed, and then select Yes.

g Related Links
• "Correcting the Image Shape with Quick Corner" p.54
• "Correcting Image Shape with Point Correction" p.59

Correcting Image Shape with Point Correction

You can use the projector's Point Correction setting to fine-tune the image
shape in portions of an image. The image is divided into a grid which allows you
to move intersection points on the grid as necessary to correct distortion.

If you change the Screen Type and Screen Position settings, the
adjustments are reset.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.
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c Select the Installation menu and press [Enter].

d Select Geometry Correction and press [Enter].

e Select Point Correction and press [Enter]. Then select Yes and press
[Enter] if necessary.

f Select Point Correction and press [Enter].

For fine tuning, select Quick Corner to correct the shape and size
of an image roughly, and then select Point Correction to adjust
them precisely.

g Select the point number and press [Enter].
You see the grid on the projected image.
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If you want to change the grid color for visibility, press [Esc], then
select a different Pattern Color setting in the Point Correction
menu.

h Use the arrow buttons to move to the point you want to correct, then press
[Enter].

i Use the arrow buttons to correct distortion as necessary.

j To correct any remaining points, press [Esc] to return to the previous
screen, then repeat steps 8 and 9.

k When you are finished, press [Esc].

• To save the current shape of an image you have adjusted, select Save
Memory. You can save up to three image shapes in the memory.
s Installation > Geometry Correction > Memory > Save Memory

• To reset the Point Correction settings to their original positions, select
Reset on the Point Correction screen.

g Related Links
• "Correcting the Image Shape with Quick Corner" p.54
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You can resize the image using the projector's menu.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Digital Zoom and press [Enter].

e Press the left or right arrow button to adjust the zoom setting and press
[Enter].

f Press [Menu] or [Esc] to exit the menus.
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You can use the Image Shift feature to adjust the image position without
moving the projector.

• This feature is available when you reduce the image using the Digital
Zoom setting.

• We recommend adjusting the image position at least 30 minutes after
you start projecting, because images are not stable right after turning
on the projector.

• You cannot use the Epson Setting Assistant app and the Image Shift
feature together. If you want to adjust the screen size and position when
using the Epson Setting Assistant app, adjust with Quick Corner.

a Turn on the projector and display an image.

b Press the [Menu] button on the control panel or remote control.

c Select the Installation menu and press [Enter].

d Select Image Shift and press [Enter].
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e Use the arrow buttons to adjust the image position.

f Press the [Esc] button to close the adjustment screen.
The adjustment screen disappears if no operation is performed after
approximately 10 seconds.

The Image Shift setting is retained even if the projector is turned off. You
need to re-adjust the position if you change the installation location or
angle of the projector.
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When multiple image sources are connected to the projector, such as a
computer and DVD player, you can switch from one image source to the other.

a Make sure the connected image source you want to use is turned on.

b For video image sources, insert a DVD or other video media and press
play.

c Do one of the following:
• Press the [Source] button on the projector until you select the source

you want.

• Press the button for the source you want on the remote control.
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The projector can display images in different width-to-height ratios called
aspect ratios. Normally, the input signal from your video source determines
the image's aspect ratio.
If you always want to use a particular aspect ratio for a certain video input
source, you can select it using the projector's Image menu.

g Related Links
• "Changing the Image Aspect Ratio" p.66
• "Available Image Aspect Ratios" p.66

Changing the Image Aspect Ratio

You can change the aspect ratio of the displayed image.

• Set the Screen Type setting in the projector's Installation menu before
changing the aspect ratio.

• Available only when the current source is HDMI.

a Turn on the projector and switch to the image source you want to use.

b Press the [Aspect] button on the remote control.

The shape and size of the displayed image changes, and the name of the
aspect ratio appears briefly on the screen.

c To cycle through the available aspect ratios for your input signal, press the
[Aspect] button repeatedly.

• The available aspect ratio setting varies depending on the input signal.
• If there are margins between the edge of the image and the projected

screen frame, you can adjust the position of the image using the Screen
Position setting in the projector's Installation menu.
s Installation > Screen Type > Screen Position

Available Image Aspect Ratios

You can select the following image aspect ratios, depending on the selected
Screen Type setting and the input signal from your image source.

Note that using the aspect ratio function of the projector to reduce,
enlarge, or split the projected image for commercial purposes or for public
viewing may infringe upon the rights of the copyright holder of that image
based on copyright law.

Aspect mode Description

Auto Automatically sets the aspect ratio according to the
input signal.

Full Displays images using the full size of the projection
area, but does not maintain the aspect ratio.

H-Zoom
V-Zoom

Displays images using the full width (H-Zoom) or full
height (V-Zoom) of the projection area and maintains
the aspect ratio of the image. Areas that exceed the
edges of the projected screen are not projected.

Image Aspect Ratio 66



Aspect mode Description

Native Displays images as is (aspect ratio and resolution
are maintained). Areas that exceed the edges of the
projected screen are not projected.
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The projector offers different color modes to provide optimum brightness,
contrast, and color for a variety of viewing environments and image types.
You can select the mode designed to match your image and environment, or
experiment with the available modes.

g Related Links
• "Changing the Color Mode" p.68
• "Available Color Modes" p.68
• "Turning On Automatic Luminance Adjustment" p.68

Changing the Color Mode

You can change the projector's Color Mode using the remote control to optimize
the image for your viewing environment.

a Turn on the projector and switch to the image source you want to use.

b Press the [Color Mode] button on the remote control to change the Color
Mode.

The name of the Color Mode appears briefly on the screen and then image
appearance changes.

c To cycle through all of the available color modes for your input signal,
press the [Color Mode] button repeatedly.

You can also set the Color Mode setting in the projector's Image menu.

Available Color Modes

You can set the projector to use these color modes, depending on the input
source you are using:

Color mode Description

Dynamic This is the brightest mode. Best for prioritizing
brightness.

Vivid Best for enjoying various content in a bright
environment.

Cinema Best for enjoying content such as movies.

Natural Best for faithfully reproducing the color representation
of the content.

Turning On Automatic Luminance Adjustment

You can turn on Dynamic Contrast to automatically optimize the image
luminance. This improves the image contrast based on the brightness of the
content you project.

a Turn on the projector and switch to the image source you want to use.
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b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select Dynamic Contrast and press [Enter].

e Choose one of the following options and press [Enter]:
• Normal for standard brightness adjustment.
• High Speed to adjust brightness as soon as the scene changes.

f Press [Menu] or [Esc] to exit the menus.
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You can use the projector's Frame Interpolation feature to smooth fast-moving
video by comparing consecutive image frames and inserting an intermediate
image frame between them.

Frame Interpolation is available in these conditions:
• This setting is available when using one of the following input sources:

• HDMI1
• HDMI2

• Image Processing is set to Fine in the projector's Signal I/O menu.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select Frame Interpolation and press [Enter].

e Select the level of interpolation and press [Enter].

f Press [Menu] or [Esc] to exit the menus.
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If your resulting images contain noise, turn off the Frame Interpolation
setting.
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You can fine-tune various aspects of how colors are displayed in your projected
images.

g Related Links
• "Adjusting the Hue, Saturation, and Brightness" p.72
• "Adjusting the Gamma" p.73

Adjusting the Hue, Saturation, and Brightness

You can adjust the Hue, Saturation, and Brightness settings for individual image
colors.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select RGBCMY and press [Enter].

e Select the color to adjust, and press [Enter].
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f Do the following as necessary for each setting:
• To adjust the overall hue of the color, bluish - greenish - reddish, adjust

the Hue setting.
• To adjust the overall vividness of the color, adjust the Saturation

setting.
• To adjust the overall color brightness of the color, adjust the Brightness

setting.

g Press [Menu] or [Esc] to exit the menus.

Adjusting the Gamma

You can correct differences in projected image colors that occur between
different image sources by adjusting the Gamma setting.

To optimize the color tone according to the scene, and to obtain a more
vivid image, correct the image by adjusting the Scene Adaptive Gamma
setting.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select Gamma and press [Enter].
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e Select and adjust the correction value.

When you select a smaller value, you can reduce the overall brightness of
the image to make the image sharper. When you select a larger value, the
dark areas of images become brighter, but the color saturation for lighter
areas may become weaker.

Medical images may not be reproduced correctly depending on
your settings and screen specifications.

f If you want to make finer adjustments, select Custom and press [Enter].

g Press the left or right arrow buttons to select the color tone you want to
adjust on the gamma adjustment graph. Then press the up or down arrow
button to adjust the value and press [Enter].

h Press [Menu] or [Esc] to exit the menus.
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You can adjust the resolution of the image to reproduce a clear image with an
emphatic texture and material feel.

Noise Reduction and MPEG Noise Reduction are available when Image
Processing is set to Fine.
s Signal I/O > Image Processing

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.

c Select the Image menu and press [Enter].

d Select Image Enhancement and press [Enter].
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e Select Image Preset Mode and press [Enter].

f Select the preset option and press [Enter].

The following settings saved in the preset option are applied to the image.

• Noise Reduction
• MPEG Noise Reduction
• Super-resolution
• Auto Contrast Enhancement

g Adjust each setting in the projector's Image menu individually as
necessary.
• To reduce flickering in images, adjust the Noise Reduction setting.
• To reduce the noise or artifacts seen in MPEG video, adjust the MPEG

Noise Reduction setting.
• To reduce blurring appeared when projecting low resolution image,

adjust the Super-resolution setting.
• To create a clearer and sharper image by automatically adjusting the

contrast, adjust the Auto Contrast Enhancement setting.

The settings value in the preset option are overwritten.

h Press [Menu] or [Esc] to exit the menus.

You can also set the Image Enhancement setting in the projector's Image
menu.
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You can adjust the brightness of your projector's light source.

a Turn on the projector and switch to the image source you want to use.

b Press the [Light Output] button on the remote control.

c Use the left and right arrow buttons to select the brightness.

d Press [Menu] or [Esc] to exit the menus.

You can also set the Brightness Level setting in the projector's Image
menu.

g Related Links
• "Turning On Automatic Luminance Adjustment" p.77
• "Projector Specifications" p.174

Turning On Automatic Luminance Adjustment

You can turn on Dynamic Contrast to automatically optimize the image
luminance. This improves the image contrast based on the brightness of the
content you project.

a Turn on the projector and switch to the image source you want to use.

b Press the [Menu] button on the control panel or remote control.
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c Select the Image menu and press [Enter].

d Select Dynamic Contrast and press [Enter].

e Choose one of the following options and press [Enter]:
• Normal for standard brightness adjustment.
• High Speed to adjust brightness as soon as the scene changes.

f Press [Menu] or [Esc] to exit the menus.
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Adjusting Projector Features

Follow the instructions in these sections to use your projector's adjustment features.

g Related Links
• "HDMI Link Features" p.80
• "Projecting a PC Free Presentation" p.82
• "Projecting in Content Playback Mode" p.87
• "Shutting Off the Image Temporarily" p.93
• "Saving Settings to Memory and Using Saved Settings " p.94
• "Projector Security Features" p.95



When an audio/video source that meets the HDMI CEC standard is connected
to the projector's HDMI port, you can use the projector's remote control to
control certain features of the linked device.
Example: Projector, audio/video system, and multi-media players connection

• As long as the connected device meets the HDMI CEC standard,
you can use the HDMI Link features even if the audio/video system
in-between does not meet the HDMI CEC standard.

• Up to 3 multi-media players that meet the HDMI CEC standard can be
connected at the same time.

g Related Links
• "Operating the Connected Devices Using the HDMI Link Features" p.80

Operating the Connected Devices Using the HDMI Link
Features

You can select the connected device that is available for HDMI Link and control
the selected device using the HDMI Link features.

• When you use the HDMI Link features, set the HDMI Link setting to
On in the projector's Signal I/O menu.
s Signal I/O > HDMI Link > HDMI Link

• You must also configure the connected device. See the documentation
supplied with the device for more information.

• Some connected devices or functions of those devices may not
operate properly even if they meet the HDMI CEC standard. See the
documentation supplied with the device for more information.

• Use a cable that supports the HDMI standard.

a Press the [HDMI Link] button on the remote control.

b Make sure HDMI Link is set to On.

c Select Device Connections and press [Enter].
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d Select the device you want to control and project the image from, and
press [Enter].

• A linked device is indicated by a blue mark.
• The device name is left blank if it cannot be acquired.

e Press [Esc] to select the HDMI Link options as necessary.
• Power On Link lets you control what happens when you turn on the

projector or linked device.

• Select PJ -> Device or Bidirectional to turn the linked device
on when the projector is turned on.

• Select Device -> PJ or Bidirectional to turn the projector on
when the linked device is turned on.

• Power Off Link lets you control whether linked devices are turned off
when the projector is turned off.

• Power Off Link only works when the connected device's CEC
power link function is enabled.

• Note that depending on the status of the connected device (for
example, if it is recording), the device may not be turned off.

f Press [HDMI Link] or [Esc] to exit the menus.

You can use the projector's remote control to control the linked device such as
playback, stop, or adjust the volume.

You can also set the HDMI Link setting in the projector's Signal I/O
menu.

g Related Links
• "Input Signal Settings - Signal I/O Menu" p.122
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You can use your projector's PC Free feature whenever you connect a USB
device that contains compatible presentation files. This lets you quickly and
easily display a presentation and control it using the projector's remote control.

g Related Links
• "Supported PC Free File Types" p.82
• "Precautions on PC Free Projection" p.83
• "Starting a PC Free Slide Show" p.83
• "Starting a PC Free Movie Presentation" p.84
• "PC Free Display Options" p.85

Supported PC Free File Types

You can project these types of files using the projector's PC Free feature.

• For best results, place your files on media that is formatted in
FAT16/32.

• If you have trouble projecting from media formatted for non-Windows
file systems, try formatting the media for Windows instead.

File contents File type
(extension)

Details

Image .jpg Make sure the file is not:
• CMYK format
• Progressive format
• Highly compressed
• Above 8,192 × 8,192 resolution

.bmp Make sure the file is not:
• Above 1,280 × 800 resolution

.gif Make sure the file is not:
• Above 1,280 × 800 resolution
• Animated
• Interlaced

.png Make sure the file is not:
• Above 1,920 × 1,200 resolution
• Interlaced
When you use a projector with a resolution of 1,080p,
you can project a file with a maximum resolution of 1,920
× 1,200.

File contents File type
(extension)

Details

Movie .avi
(Motion
JPEG)

• Version: AVI 1.0 only
• Resolution: 1280 × 720 or less
• Size: 2 GB or less
• Movie Codec: Motion JPEG
• Frame Rate: up to 30 fps
• Audio Codec: LPCM or IMA ADPCM
• Audio Sampling Rate: 11.025 kHz, 16 kHz, 22.05 kHz,

24 kHz, 32 kHz, 44.1 kHz, or 48 kHz
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File contents File type
(extension)

Details

Movie .mp4/.mov
(H.264,
H265)

• Resolution: 1920 × 1200 or less
• Size: 2 GB or less
• Movie Codec: H.264/MPEG-4 AVC or H.265/MPEG-

H HEVC
• Frame Rate: up to 30 fps
• Profile:

• H.264/MPEG-4 AVC: Baseline Profile, Main Profile,
High Profile

• H.265/MPEG-H HEVC: Main Profile
• Color Format: YUV420
• Single slice structure
• Audio Codec: MPEG-2 AAC-LC, MPEG-4 AAC-LC,

or LPCM
• Audio Channel: up to 2ch (channel 2)
• Audio Bit: 8 bits or 16 bits
• Audio Sampling Rate:

• MPEG-2 AAC-LC: 44.1 kHz, 48 kHz
• MPEG-4 AAC-LC: 44.1 kHz, 48 kHz
• LPCM: 11.025 kHz, 16 kHz, 22.05 kHz, 24 kHz, 32

kHz, 44.1 kHz, or 48 kHz

Precautions on PC Free Projection

Note the following precautions when using PC Free features.
• Do not disconnect the USB storage device while it is being accessed;

otherwise, PC Free may not operate correctly.
• You may not be able to use the security features on certain USB storage

devices with PC Free features.

• When connecting a USB device that includes an AC adapter, connect the AC
adapter to an electrical outlet when you use the device with your projector.

• Some commercially available USB card readers may not be compatible with
the projector.

• The projector can recognize up to 5 cards inserted into the connected card
reader at one time.

g Related Links
• "Shutting Off the Image Temporarily" p.93

Starting a PC Free Slide Show

After connecting a USB device to the projector, you can switch to the USB input
source and start your slide show.

You can change the PC Free operation options or add special effects by
highlighting Option at the bottom of the screen and pressing [Enter].

a Press the [USB] button on the remote control until the PC Free file list
screen appears.
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• If the Select Drive screen is displayed, press the arrow buttons to
select the drive and press [Enter].

• To display images on the other USB drive, highlight Select Drive
at the top of the file list screen and press [Enter].

b Do one of the following to locate your files:
• If you need to display files inside a subfolder on your device, press the

arrow buttons to highlight the folder and press [Enter].
• To move back up a folder level on your device, highlight Back to Top

and press [Enter].
• To view additional files in a folder, highlight Next Page or Previous

Page and press [Enter].

c Do one of the following:
• To display an individual image, press the arrow buttons to highlight the

image and press [Enter]. (Press the [Esc] button to return to the file list
screen.)

• To display a slide show of all the images in a folder, press the arrow
buttons to highlight the Slideshow option at the bottom of the screen
and press [Enter].

• You can change the image switching time by highlighting Option
at the bottom of the screen and pressing [Enter].

• If any file names are longer than the display area or include
unsupported symbols, the file names may be shortened or
changed only on the screen display.

d While projecting, use the following commands to control the display:
• To rotate a displayed image, press the up or down arrow button.

• To move to the next or previous image, press the left or right arrow
button.

e To stop the display, follow the on-screen instructions or press the [Esc]
button.
You return to the file list screen.

f Turn off the USB device, if necessary, and then disconnect the device from
the projector.

g Related Links
• "Connecting to a USB Device" p.29
• "PC Free Display Options" p.85

Starting a PC Free Movie Presentation

After connecting a USB device to the projector, you can switch to the USB input
source and start your movie.
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You can change the PC Free operation options by highlighting Option at
the bottom of the screen and pressing [Enter].

a Press the [USB] button on the remote control until the PC Free file list
screen appears.

• If the Select Drive screen is displayed, press the arrow buttons to
select the drive and press [Enter].

• To display images on the other USB drive, highlight Select Drive
at the top of the file list screen and press [Enter].

b Do one of the following to locate your files:
• If you need to display files inside a subfolder on your device, press the

arrow buttons to highlight the folder and press [Enter].
• To move back up a folder level on your device, highlight Back to Top

and press [Enter].
• To view additional files in a folder, highlight Next Page or Previous

Page and press [Enter].

c To play back a movie, press the arrow buttons to highlight the file and
press [Enter].

• If any file names are longer than the display area or include
unsupported symbols, the file names may be shortened or
changed only on the screen display.

• If you want to play back all the movies in a folder in sequence,
select the Slideshow option at the bottom of the screen.

d To stop movie playback, press the [Esc] button, highlight Exit, and press
[Enter].
You return to the file list screen.

e Turn off the USB device, if necessary, and then disconnect the device from
the projector.

g Related Links
• "Connecting to a USB Device" p.29
• "PC Free Display Options" p.85

PC Free Display Options

You can select these display options when using PC Free. To access this screen,
highlight Option at the bottom of the PC Free file list screen and press [Enter].
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Setting Options Description

Display Order Name Order Displays files in name order

Date Order Displays files in date order

Sort Order In Ascending Sorts files in first-to-last order

In Descending Sorts files in last-to-first order

Continuous Play On Displays a slide show continuously

Off Displays a slide show once

Screen Switching
Time

No Does not display the next file
automatically

1 Second to 60 Seconds Displays files for the selected time and
switches to the next file automatically;
high resolution images may switch at
a slightly slower rate

Effect No No effect

Wipe Transitions between images using a
wipe effect

Dissolve Transitions between images using a
dissolve effect

Setting Options Description

Random Transitions between images using a
random variety of effects
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Your projector's Content Playback feature allows you to project your digital
signage content. You can easily project playlists that contain images and movies
saved on an external storage device. You can also add color and shape effects to
your projected image.

g Related Links
• "Switching to Content Playback Mode" p.87
• "Projecting Your Playlists" p.88
• "Adding Effects to Your Projected Image" p.90
• "Content Playback Mode Restrictions" p.92

Switching to Content Playback Mode

Before you project your playlists, you need to switch to Content Playback mode.

If you set the Content Playback setting to On when the Screen Type
setting is set to a different aspect ratio from the projector's resolution, the
Screen Type setting is reset.

a Turn on the projector.

b Press the [Menu] button, select the Operation menu, and then press
[Enter].

c Select the Content Playback setting and set it to On.
You see a confirmation prompt.

d Turn off the projector, then turn it on again to enable Content Playback
mode.
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Projecting Your Playlists

You can project playlists that contain images and movies in Content Playback
mode.

a Create your playlists and export them to a USB flash drive using one of the
following methods:
• The Epson Projector Content Manager software lets you create playlists

and save them on an external storage device. You can also add color and
shape effects to your projected image, and schedule playlists.
You can download and install Epson Projector Content Manager from
the following Web site.
epson.sn
See the Epson Projector Content Manager Operation Guide for
instructions.

• Epson Web Control allows you to create playlists using a Web browser
and save them to an external storage device connected to a projector on
a network. You can also add color and shape effects to your projected
image.

• The Epson Creative Projection app lets you create content on iOS
devices. You can also transfer content to the projector wirelessly.
You can download Epson Creative Projection from the App Store.
Any fees incurred when communicating with the App Store are the
responsibility of the customer.

b In Content Playback mode, connect the USB flash drive into the
projector's USB-A port.

c Press the [USB] button on the remote control.

The playlist that was played last is projected. If there is a timetable
assigned, the playlist will play back according to the schedule in the
timetable.

To select the target playlist from the list, select USB Viewer in the
projector's Operation menu, and use the arrow buttons.

g Related Links
• "Creating Playlists Using Epson Web Control" p.88
• "Getting the Latest Version of the Documents" p.8

Creating Playlists Using Epson Web Control

In Content Playback mode, you can create playlists using a Web browser and
save them to a USB flash drive connected to a projector on a network.

Attention
Do not remove the USB flash drive from the projector or disconnect the projector's
power cord while creating playlists. Data saved on the USB flash drive may be
damaged.

a Make sure the projector is operating in Content Playback mode.
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b Make sure your computer or device is connected to the same network as
the projector.

c Make sure a USB flash drive is connected to the projector's USB-A port.

d Start your Web browser on your computer or device.

e Go to the Epson Web Control screen by entering the projector's IP address
into the browser's address box. When entering an IPv6 address, wrap the
address with [ and ].

f Select USB Memory Device.

g Select Upload New Data.

h Select the images or movies you want to add to the playlist.

You can upload .avi, .jpeg (.jpg), .png, .bmp, or .gif files.
If you want to add .mp4 or .mov files to the playlist, use the
Epson Projector Content Manager software or the Epson Creative
Projection app.

The selected files are copied to the connected USB flash drive.

i Do one of the following:
• To add them to the existing playlist, select Add to Playlist and select

the playlist you want to add them to.
• To create a new playlist and add them to it, select Create New Playlist.

Projecting in Content Playback Mode 89



j Edit the playlist.

A Edits the playlist name.

B Selects whether to enable repeat playback or not.

C Registers the playlist to your favorites.
When a playlist has been registered as a favorite, you can start playback
quickly using the Remote screen or the remote control.

D Displays the images or movies you have added to the playlist. The playlist
plays the images or movies in order.

E Adds images or movies to the playlist.

F Deletes images or movies from the playlist.

G Opens the Switch Image screen.
You can specify the time interval to switch to the next image file. You can also
select a transition effect.

H Opens the Effects screen.
You can add predefined color and shape effect filters to a playlist. You can
also create a customized effect.

I Previews the playlist.

k When you have finished editing the playlist, select Finish.

• You can play the playlist from the Remote or Playlist screen.
• When you want to specify when the playlist starts and finishes,

schedule the playlist using the Epson Projector Content Manager
software.

g Related Links
• "Web Control Options" p.101

Adding Effects to Your Projected Image

You can add color and shape effects to the projected image in Content Playback
mode.

To use the effect functions, make sure you perform Refresh Mode
regularly.
sManagement > Refresh Mode
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a In Content Playback mode, press the [Menu] button, select the Operation
menu, and then press [Enter].

b Select Overlay Effect and press [Enter].

c Select On as the Overlay Effect setting and press [Enter].

d Select Shape Filter and press [Enter].

e Adjust each of the following options as necessary:
• Shape to select the shape effect you want from circles, rectangles, or

customized shapes.

You can add your images as customized shapes using the Epson
Projector Content Manager software. See the Epson Projector
Content Manager Operation Guide for details.

• Filter Effect to select whether to mask inside or outside of the selected
shape.

• Size to set the shape size.
• Position to set the shape position.

When you use a customized shape, you cannot change the Size
and Position settings.

f Select Color Filter and press [Enter].

g Adjust each of the following options as necessary:
• Color Filter to select the color.
• Custom to set a customized color by adjusting Red, Green, and Blue

individually.

h Select Lightness to set the brightness level.

i When you are finished, press [Menu] to exit the menus.
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Content Playback Mode Restrictions

Operating restrictions
The following operations cannot be performed in Content Playback mode.
• Changing the Color Temp. setting in the Image menu (when Warm White

or Cool White is selected as Color Filter)
• Changing the Screen Type setting in the Installation menu
• Changing the No-signal Screen setting in the Display menu
• Changing the Log Save Destination setting in the Management menu
• Detecting the input signal automatically
• Changing Remote Password in the Network Settings menu
• PC Free

g Related Links
• "Image Quality Settings - Image Menu" p.120
• "Setting the Screen Type" p.47
• "Network Menu - Network Settings Menu" p.131
• "Projecting a PC Free Presentation" p.82
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You can temporarily shut off the projected image and output sound only.

a Press the [Blank] button on the remote control to temporarily shut off
projection. Note that sound is output.

b To turn the image back on, press the [Blank] button again.

Any video action continues to run, however, so you cannot resume
projection at the point that you stopped it.
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You can save customized settings and then select the saved settings whenever
you want to use them.

a Turn on the projector and display an image.

b Press the [Menu] button on the remote control, select the Memory menu,
and press [Enter].

c Select one of the following options:
• Save Memory lets you save your current settings to memory (10

memories with different names are available).

• You can save the following settings:
• Image menu settings for each color mode
• Video Range in the Signal I/O menu
• Light Source Mode and Brightness Level in the

Operation menu
• A memory name that has already been used is indicated by a

blue mark. Saving over a previously saved memory overwrites
the settings with your current settings.

• Load Memory lets you overwrite your current settings with saved
settings.

• Rename Memory lets you rename a saved memory.
• Erase Memory lets you erase the selected memory settings.

d Press [Menu] or [Esc] to exit the menus.

• The saved Color Mode is displayed on the right of the memory name.
• To delete all saved memories, select Reset Memory Settings.

g Related Links
• "Image Quality Settings - Image Menu" p.120
• "Input Signal Settings - Signal I/O Menu" p.122
• "Projector Feature Settings - Operation Menu" p.127
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You can secure your projector to deter theft or prevent unintended use by
setting up the following security features:
• Button lock security to block operation of the projector using the buttons on

the control panel.
This is useful at events or shows when you want to deactivate all buttons
during projection or at schools when you want to limit button operation.

• Security cabling to physically secure the projector in place.

g Related Links
• "Locking the Projector's Buttons" p.95
• "Installing a Security Cable" p.96
• "Secure HTTP" p.96

Locking the Projector's Buttons

You can lock the buttons on the projector to prevent anyone from using the
projector.

a Press the [Menu] button, select the Management menu, and press [Enter].

b Select one of these lock types and press [Enter]:
• To lock the projector's power button, select Child Lock.

To turn the projector on, you must press the power button for longer
than three seconds.

Child Lock does not prevent the projector from turning on when
the power cord is connected if Direct Power On is set to On in
the projector's Operation menu.

• To lock all buttons on the projector, select Control Panel Lock > Full
Lock.
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You can use the remote control to control the projector even
when the buttons on the projector are locked.

• To lock all buttons on the projector except the power button, select
Control Panel Lock > Except for Power.

c If you see a confirmation prompt, select Yes and press [Enter].
The Control Panel Lock setting is applied.

d Restart the projector to apply the Child Lock setting.

g Related Links
• "Unlocking the Projector's Buttons" p.96
• "Projector Feature Settings - Operation Menu" p.127
• "Projector Administration Settings - Management Menu" p.129

Unlocking the Projector's Buttons

If the projector's buttons have been locked, do one of the following to unlock
them.
• Set Child Lock to Off in the projector's Management menu.
• Set Control Panel Lock to Off in the projector's Management menu.

You can also release Control Panel Lock by holding down the [Enter]
button on the control panel for seven seconds. A message is displayed
and the lock is released.

g Related Links
• "Projector Administration Settings - Management Menu" p.129

Installing a Security Cable

You can install the security cable on the projector to deter theft.
Use the security slot on the projector to attach a Kensington Microsaver
Security system.

For more details on the Microsaver Security System, visit the Kensington
Web site.
https://www.kensington.com/

Secure HTTP

You can use the HTTPS protocol to increase security between the projector and
a Web browser communicating with it. To do this, you create a server certificate,
install it on the projector, and turn on the Secure HTTP setting in the projector
menus to verify the reliability of the Web browser.
Even if you do not install a server certificate, the projector automatically
creates a self-signed certificate and allows communication. However, because
the self-signed certificate cannot verify reliability from a Web browser, you see a
warning about the server's reliability when you access the projector from a Web
browser. This warning does not prevent communication.

g Related Links
• "Importing a Web Server Certificate Using the Menus" p.96
• "Supported Web Server Certificates" p.97

Importing a Web Server Certificate Using the Menus

You can create your Web server certificate and import it using the projector
menus and an external storage device.
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• You can use a USB flash drive as an external storage device for this
model.

• You can also register the digital certificates from your Web browser.
However, be sure to register just once or the certificate may not install
correctly.

a Make sure your digital certificate file is compatible with projector
registration and directly placed on the USB storage device.

b Press the [Menu] button, select the Network menu, and press [Enter].

c Select Network Settings and press [Enter].

d Select the Projector Control menu and press [Enter].

e Set the Secure HTTP setting to On.

f Select Web Server Certificate and press [Enter].

g Select Register and press [Enter].

h Follow the on-screen instructions to connect a USB storage device to the
projector's USB-A port.

i Press [Enter] to display the certificate list.

j Select the certificate to import using the displayed list.
A message is displayed prompting you to enter the password for the
certificate.

k Enter a password and press [Enter].
The certificate is imported and a completion message appears.

Supported Web Server Certificates

You can register these types of digital certificates.

Web Server Certificate (Secure HTTP)

Specification Description

Format PKCS#12

Extension PFX, P12

Encryption RSA

Hashes MD5/SHA-1/SHA-256/SHA-384/SHA-512

Key length 512/1024/2048/4096 bit

Common name Network host name

Organization Optional
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Specification Description

Password Up to 64 alphanumeric characters; required
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Monitoring and Controlling the Projector

Check these sections to monitor and control the projector over a network.

g Related Links
• "Controlling a Networked Projector Using a Web Browser" p.100
• "Registering Digital Certificates from a Web Browser" p.108
• "Using ESC/VP21 Commands " p.109
• "PJLink Support" p.110
• "Crestron Connected Support" p.111
• "Web API" p.113
• "Setting Projector Event Schedules" p.114



Once you have connected your projector to your network, you can select
projector settings and control projection using a compatible Web browser. This
lets you access the projector remotely.
In Content Playback mode, you can also edit playlists.

Attention
In Content Playback mode, do not remove the USB flash drive from the projector or
disconnect the projector's power cord in the following situations. Data saved on the
USB flash drive may be damaged.
• When the Playlists screen is displayed
• When the USB Memory Device screen is displayed

• Make sure the computer and projector are connected to the network.
• You can use the following Web browsers.

• Microsoft Edge (Windows)
• Safari (Mac, iOS)
• Chrome (Android)

• While using the Web browser, do not connect using a proxy server. You
cannot select all of the projector menu settings or control all projector
functions using a Web browser.

• If you set the Standby Mode setting to Communication On in the
projector's Operation menu, you can use a Web browser to select
settings and control projection even if the projector is in standby mode
(when the power is off).

a Make sure the projector is turned on.

b Make sure your computer or device is connected to the same network as
the projector.

c Start your Web browser on the computer or device.

d Go to the Epson Web Control screen by entering the projector's IP
address into the browser's address box. When entering an IPv6 address,
wrap the address with [ and ].
You see the Epson Web Control screen.
• In normal mode

A Controls the projector remotely.

B Displays a test pattern.

C Sets detailed projector settings.

D Opens the Crestron Connected and Crestron XiO Cloud operation
windows.

E Operates the projector's menu settings with your finger or mouse.

• In Content Playback mode
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A Controls the projector remotely.

B Selects the playlist you want to play, and allows you to create or edit
playlists.

C Displays the Time Table screen.

D Operates the projector's menu settings with your finger or mouse.

E Opens the Crestron Connected and Crestron XiO Cloud operation
windows.

F Sets detailed projector settings.

G Displays a test pattern.

H Registers or deletes the data for a playlist on the USB flash drive.

e Select the option corresponding to the projector function you want to
control.

You may need to log in to access some of the options on the Epson
Web Control screen. Set the following passwords first.
• To access the Basic Control option, you need to log in using

EPSONREMOTE as the user name and your Remote Password.
(No password is set by default.)
Set Basic Control to On in the projector's Network menu, and
then set the password.
sNetwork > Network Settings > Projector Control > Basic
Control

• To access other options and save settings, you need to log in
using EPSONWEB as the user name and your Web Control
Password. (No password is set by default.)
Set the password in the projector's Network menu.
sNetwork > Network Settings > Web Control Password

g Related Links
• "Web Control Options" p.101

Web Control Options

Basic Control
Options on the Basic Control screen allow you to select the input source and
control the projector.
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A Returns to the Epson Web Control screen.

B Turns the projector on.

C Selects the input source. (The available sources vary depending on your projector
model.)

D Turns the video on or off temporarily. If external speakers are connected, the audio
will continue to play.

E Adjusts the volume of any external speakers.

F Turns the projector off.

OSD Control Pad
Options on the OSD Control Pad screen allow you to display the projector's
setting menus and select them moving your finger or mouse on the pad.

A Returns to the Epson Web Control screen.

B Displays the projector's setting menus.

C Use your finger or mouse to navigate the menus.

D Resets the selected setting to its default value.

E Returns to the previous menu.

F Displays help topics.

Test Pattern
The Test Pattern screen displays the available test patterns and allow you to
select to project it.
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A Returns to the Epson Web Control screen.

B Displays available test patterns; select to project a test pattern. (The available test
patterns vary depending on your projector model.)

C Turns off test pattern display.

Advanced
The Advanced screen allow you to select the projector's settings.

A Opens the menus.

B Displays the menu name you selected.

C Specifies the projector settings. (The available settings vary depending on your
projector model.)

D Locks/unlocks the projector settings.
Locking prevents accidental changes to the Epson Web Control settings.

E Updates the projector settings.
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You cannot change the following settings using Epson Web Control.
• HDMI Link
• Fixed Installation
• Setting Plate Installation Guide
• Image Shift
• Install Again
• Content Playback
• Language
• Display Status
• Reset Network Settings
• Firmware Update

You can select the following settings only with Epson Web Control.
• Initial Setting
• Monitor Password (up to 16 alphanumeric characters)

When performing command communication for the first time, you
must set a password in the web browser.

• IPv6 Settings (manual)
• HTTP port (port number used for Web Control except for 80 [default],

843, 3620, 3621, 3625, 3629, 4352, 4649, 5357, 10000, 10001, 41794)
• Display Logs

Remote (only in Content Playback mode)
Options on the Remote screen allow you to select the input source, control the
projector, and start projecting playlists.

A Returns to the Epson Web Control screen.

B Turns the projector on or off.

C Selects the input source. (The available sources vary depending on your projector
model.)

D Turns the video on or off temporarily.

E Overlay Effect option is displayed when the current source is anything other than
USB.
Turns Overlay Effect on or off to add color and shape effects to a playlist.
When turning on, the Effects screen is displayed. You can add predefined color and
shape effect filters to a playlist. You can also create a customized effect.

F Specifies the screen settings.

G Displays your favorite playlists. Select a playlist to start projecting.
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H Displays information for the playlist being projected.
The icons indicate the playlist settings.

: Overlay effects have been applied

: Repeat playback has been applied

: Length of the playlist
Select the arrow at the bottom-right to display the following screen.

Screen displayed while projecting playlist (only in Content Playback mode)

A Stops projection.

B Turns the video on or off temporarily.

C Opens the Effects screen. You can select preset effects or select individual
brightness, color, and shape effect filters.

Playlist (only in Content Playback mode)
Options on the Playlist screen allow you to select the playlist you want to play
from the list, and create or edit playlists.

A Returns to the Epson Web Control screen.

B Starts projecting the playlist.
The icons indicate the playlist settings.

: Number assigned to your favorite playlists

: Repeat playback has been applied

: Overlay effects have been applied

C Opens the menu that allows you to edit, copy, register to your favorites, or delete
the playlist.
When you select Edit or Duplicate, the Edit Playlist screen is displayed.

D Opens the New Playlist screen where you can create a new playlist.
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New Playlist/Edit Playlist screen (only in Content Playback mode)

A Edits the playlist name.

B Selects whether to enable repeat playback or not.

C Registers the playlist as favorites.
When registering favorites, you can quickly start playback of the favorite playlist
using the Remote screen or the remote control.

D Displays the images or movies you have added to the playlist. The playlist plays the
images or movies in order.

E Adds images or movies to the playlist.

F Deletes images or movies from the list.

G Opens the Switch Image screen.
You can specify the time interval to switch to the next image file. You can also select
a transition effect.

H Opens the Effects screen.
You can add predefined color and shape effect filters to a playlist. You can also
create a customized effect.

I Previews the playlist.

USB Memory Device (only in Content Playback mode)
Options on the USB Memory Device screen allow you to upload data for a
playlist to the USB flash drive or delete the data on the USB flash drive.

You can upload .avi, .jpeg (.jpg), .png, .bmp, or .gif files.
If you want to add the .mp4 and .mov files to the playlist, use the Epson
Projector Content Manager software or the Epson Creative Projection app.

A Returns to the Epson Web Control screen.

B Copies images or movies you want to add to playlists to a USB flash drive.

C Deletes images or movies on the USB flash drive.
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Time Table (only in Content Playback mode)
Options on the Time Table screen allow you to enable or disable the specified
time table features.

A Returns to the Epson Web Control screen.

B Turns the time table on or off.

You can specify when each playlist starts and finishes using the time table
feature in the Epson Projector Content Manager software.
For details, see the Epson Projector Content Manager Operation Guide.
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You can register the digital certificates on the projector to provide security for
your presentation files.

You can also register the digital certificates in the projector's Network
menu. However, be sure to register just once or the certificate may not
install correctly.
sNetwork > Network Settings > Projector Control > Secure HTTP >
Web Server Certificate

a Make sure your digital certificate file is compatible with projector
registration.

b Make sure the projector is turned on.

c Start your Web browser on a computer or device connected to the
network.

d Go to the Epson Web Control screen by entering the projector's IP address
into the browser's address box.

e Select Advanced.

• You may need to log in before the Advanced screen is displayed.
If you see a log in window, enter your user name and password.
(The user name is EPSONWEB. No password is set by default. If
no Web Control Password has been set, a browser error screen is
displayed. Set the password in the Network Settings menu.)

• You can change the password in the projector's Network menu.
sNetwork > Network Settings > Web Control Password

f Select  to open the menus, select Network, and select Certificate.

g Select the certificate file you want to register.

h Enter the password in the Password box, and then click Send.

i When you finish registering the certificate, click Apply to finalize your
changes and complete the registration.
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You can control the projector from an external device using ESC/VP21.

g Related Links
• "ESC/VP21 Command List" p.109
• "Cable Layouts" p.109

ESC/VP21 Command List

When the power ON command is transmitted to the projector, the power turns
on and it enters warm-up mode. When the projector's power has turned on, a
colon ":" (3Ah) is returned.
When a command is input, the projector executes the command and returns a
":", and then accepts the next command.
If the command being processed terminates abnormally, an error message is
output and a ":" is returned.
You can check the available commands in the projector's Specifications.

g Related Links
• "Getting the Latest Version of the Documents" p.8

Cable Layouts

Serial connection
• Connector shape: D-Sub 9-pin (male)
• Projector input port name: RS-232C
• Cable type: Crossover (null modem) cable
In the following illustration, the projector side is shown on the left, and the
computer side on the right:

Signal name Function

GND Signal wire ground

TD Transmit data

RD Receive data

Communications protocol
• Default baud rate setting: 9600 bps
• Data length: 8 bit
• Parity: None
• Stop-bit: 1 bit
• Flow control: None
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PJLink was established by the JBMIA (Japan Business Machine and Information
System Industries Association) as a standard protocol for controlling network-
compatible projector's as part of their efforts to standardize projector control
protocols.
The projector complies with the PJLink Class2 standard established by the
JBMIA.
The port number used for the PJLink search function is 4352 (UDP).
You need to activate PJLink and set the PJLink Password before you can use
PJLink.
sNetwork > Network Settings > Projector Control > PJLink
It complies with all commands except for the following commands defined
by PJLink Class2, and agreement was confirmed by the PJLink standard
adaptability verification.
http://pjlink.jbmia.or.jp/english/
• Non-compatible commands

You can check the non-compatible commands in the projector's
Specifications.

• Input ports and corresponding input source number

Input port name Input source number

HDMI1 32

HDMI2 33

USB 41

• Manufacturer name displayed for "Manufacture name information query"
EPSON

• Model name displayed for "Product name information query"
EPSON 815E/810E

g Related Links
• "Getting the Latest Version of the Documents" p.8
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If you are using the Crestron Connected network monitoring and control
system, you can set up your projector for use on the system. Crestron
Connected lets you control and monitor your projector using a Web browser.

If you set the Standby Mode setting to Communication On in the
projector's Operation menu, you can control the projector even if the
projector is in standby mode (when the power is off).

For additional information on Crestron Connected, visit the Crestron Web site.
https://www.crestron.com/
To monitor devices in the system, you can use Crestron RoomView Express or
Crestron Fusion provided by Crestron. You can communicate with the help desk
and send emergency messages. See the following Web site for details.
http://www.crestron.com/getroomview
To monitor or control your projector and other various devices over a network,
you can use Crestron XiO Cloud. You can manage multiple devices from one
location. See the following Web site for details.
https://www.crestron.com/Products/Featured-Solutions/XiO-Cloud
This manual describes how to perform operations on your computer using a
Web browser.

g Related Links
• "Setting Up Crestron Connected Support" p.111

Setting Up Crestron Connected Support

To set up your projector for monitoring and control using a Crestron Connected
system, make sure your computer and projector are connected to the network.

a Press the [Menu] button, select the Network menu, and press [Enter].

b Select Network Settings and press [Enter].

c Select the Projector Control menu and press [Enter].

d Set the Crestron Connected setting to On to allow the projector to be
detected.

• If no password has been set, a screen prompting you to set a
password is displayed before you can set Crestron Connected to
On. Follow the on-screen instructions to set the password.

• To enable the Crestron XiO Cloud service, set Crestron XiO
Cloud to On.

e When you finish selecting settings, go back to the Network Settings
screen, select Set, and follow the on-screen instructions to save your
settings and exit the menus.

f Turn off the projector, and then turn it on again to enable the setting.

Crestron Connected Support 111

https://www.crestron.com/
http://www.crestron.com/getroomview
https://www.crestron.com/Products/Featured-Solutions/XiO-Cloud


g Start your Web browser on a computer or device connected to the
network.

h Go to the Epson Web Control screen by entering the projector's IP address
into the browser's address box.

i Select the Crestron Connected settings. See the Crestron Web site for
details.
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You can use Web API to operate the projector in Content Playback mode. See
the Web API Specifications for Projectors for details.

• You can authenticate Web API communications using API
authentication (Digest authentication).

• The user name for API authentication is EPSONWEB; use the
password that is set for Web Control Password.
sNetwork > Network Settings > Web Control Password

g Related Links
• "Enabling Web API" p.113

Enabling Web API

You can enable Web API using the projector's menu.

a Press the [Menu] button, select the Network menu, and press [Enter].

b Select Network Settings and press [Enter].

c Select Projector Control and press [Enter].

d Select Web API Settings.

e Set Web API to On.
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You can schedule up to 30 events to occur automatically on your projector, such
as turning the projector on or off or switching the input source. The projector
performs the selected events on the specified date and time in the schedule you
set up.

Warning
Do not place flammable objects in front of the lens. If you schedule the projector to
turn on automatically, flammable objects in front of the lens could catch on a fire.

a Set the date and time in the Date & Time menu in the projector's
Management menu.

b Press the [Menu] button, select the Management menu, and press [Enter].

c Select Schedule Settings and press [Enter].

d Select Schedule and press [Enter].

e Select Add New and press [Enter].
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f Select the event details you want to perform.

g Select the date and time at which you want the event to occur.

h Select Save and press [Enter].
The scheduled events are displayed on the screen with icons indicating the
event status.

A : valid schedule

: regular schedule

: invalid schedule

B The date currently selected (highlighted)

C : one time schedule

: regular schedule

: standby schedule (turns communication on or off during standby)

: invalid schedule

i To edit a scheduled event, select the schedule and press [Enter].
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j Select an option from the menu displayed.
• On or Off lets you enable or disable the selected event.
• Edit lets you change the event details or date and time.
• Clear lets you remove the scheduled event from a list.
• Add New lets you add a new event on the same day that already has an

event scheduled.

k Select Complete to close the Schedule Settings.

To delete all scheduled events, select Reset.
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Adjusting the Menu Settings

Follow the instructions in these sections to access the projector menu system and change projector settings.

g Related Links
• "Using the Projector's Menus" p.118
• "Using the Displayed Keyboard" p.119
• "Image Quality Settings - Image Menu" p.120
• "Input Signal Settings - Signal I/O Menu" p.122
• "Projector Installation Settings - Installation Menu" p.124
• "Projector Display Settings - Display Menu" p.126
• "Projector Feature Settings - Operation Menu" p.127
• "Projector Administration Settings - Management Menu" p.129
• "Projector Network Settings - Network Menu" p.131
• "Image Quality Memory Settings - Memory Menu" p.134
• "Projector Setup Settings - ECO Menu" p.135
• "Projector Initial Settings and Reset Options - Initial/All Settings Menu" p.136
• "Copying Menu Settings Between Projectors (Batch Setup)" p.137



You can use the projector's menus to adjust the settings that control how your
projector works. The projector displays the menus on the screen.

a Press the [Menu] button on the control panel or remote control.

You see the menu screen.

b Press the up or down arrow buttons to move through the menus listed on
the left. The settings for each menu are displayed on the right.

The available settings depend on the current input source.

c To change settings in the displayed menu, press [Enter].

d Press the up or down arrow button to move through the settings.

e To return all the menu settings to their default values, select Initial/All
Settings.

f When you finish changing settings on a menu, press [Esc].

g Press [Menu] or [Esc] to exit the menus.

The  arrow indicates that the menu contains sub items. When you turn
on a menu setting or select a specific value for it, the menu system displays
the sub items.
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You can use the displayed keyboard to enter numbers and characters.

a Use the arrow buttons on the control panel or remote control to highlight
the number or character you want to enter and press the [Enter] button.

Each time you select the A/a key, the characters change between
upper case and lower case. Each time you select the SYM1/2 key, the
symbols enclosed by the frame change.

b After entering the text, select OK on the keyboard to confirm your entries.
Select Cancel to cancel entering text.

You can select projector settings and control projection over a network
using a Web browser from your computer.
Some symbols cannot be entered using the displayed keyboard. Use your
Web browser to enter the text.

g Related Links
• "Available Text Using the Displayed Keyboard" p.119

Available Text Using the Displayed Keyboard

You can enter the following text when using the displayed keyboard.

Text type Details

Numbers 0123456789

Alphabet ABCDEFGHIJKLMNOPQRSTUVWXY
Z
abcdefghijklmnopqrstuvwxyz

Symbols ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^
_ ` { | } ~

Using the Displayed Keyboard 119



Settings on the Image menu let you adjust the quality of your image. The
available settings depend on the currently selected color mode and input source.

Setting Options Description

Color Mode See the list of
available color
modes

Adjusts the vividness of image colors for
various image types and environments.

Brightness Various levels
available

Lightens or darkens the overall image.

Contrast Various levels
available

Adjusts the difference between light and
dark areas of the image.

Color Saturation Various levels
available

Adjusts the intensity of the image colors.

Tint Various levels
available

Adjusts the balance of green to magenta
tones in the image.

Setting Options Description

Sharpness Various levels
available

Adjusts the sharpness or softness of image
details.

White Balance Color Temp. Sets the color temperature according to
the color mode you selected. Higher
values tint the image blue and lower
values tint the image red.
Setting is only displayed when Color
Filter is not set to Warm White or Cool
White.
sOperation > Content Playback >
Overlay Effect > Color Filter

G-M Correction Makes fine adjustments to the color tone.
Higher values tint the image green and
lower values tint the image red.

Custom Adjusts the individual R (red), G (green),
and B (blue) components of the offset and
gain.

Grayscale Adjusts the red, green, blue, and
brightness for the selected adjustment
level.

Frame
Interpolation

Off
Low
Normal
High

Adjusts the smoothness of image
movement.
Setting is only displayed in the following
cases:
• The current source is HDMI.
• Image Processing is set to Fine.
s Signal I/O > Image Processing

Dynamic Contrast High Speed
Normal
Off

Adjusts the projected luminance based on
the image brightness.

Image
Enhancement

Image Preset Mode Sets the Image Enhancement options as
a batch using preset values.
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Setting Options Description

Noise Reduction Reduces flickering in images.
This setting is displayed only when Image
Processing is set to Fine.
s Signal I/O > Image Processing

MPEG Noise
Reduction

Reduces the noise or artifacts seen in
MPEG video.
This setting is only displayed when Image
Processing is set to Fine.
s Signal I/O > Image Processing

Super-resolution Reduces blurring when projecting low
resolution images.

Auto Contrast
Enhancement

Creates a clearer and sharper image by
automatically adjusting the contrast of the
projected image.

Reset Resets all adjustment values on the Image
Enhancement setting to their default
settings.

Dynamic Tone
Mapping

On
Off

Set to On to optimize the PQ (Perceptual
Quantizer) curve settings based on the
brightness of the projected HDR content.
Improves visibility of dark and bright
images.
This setting is displayed only when
Dynamic Range is set to Auto and Signal
Status is set to HDR10.
s Signal I/O > Dynamic Range >
Signal Status

Scene Adaptive
Gamma

Various levels
available

Adjusts the coloring according to the
scene, and obtains a more vivid image.
Select a large number to enhance
contrast.

Setting Options Description

Gamma -2 to 2
Custom
Reset

Adjusts the coloring by selecting one of
the gamma correction values, or referring
to a gamma graph.

RGBCMY Various levels
available

Adjusts the hue, saturation, and
brightness of each color R (red), G
(green), B (blue), C (cyan), M (magenta),
Y (yellow) individually.

Reset to Defaults — Resets all settings for the current color
mode.

Source — Displays settings saved for each input
source.
To change settings for an input source,
make sure the source is connected and
select that source.

Aspect See the list of
available aspect
ratios

Sets the aspect ratio (width-to-height
ratio) for the selected input source.
This setting is displayed only when the
current source is HDMI.

Reset to Defaults — Resets all settings for current input
source.

Reset Image
Settings

— Resets all adjustment values on the Image
menu to their default settings.

The Brightness setting does not affect light source brightness. To change
the light source brightness, select the Light Source Brightness Control
setting in the projector's Operation menu.

g Related Links
• "Adjusting the Image Color" p.72
• "Available Color Modes" p.68
• "Available Image Aspect Ratios" p.66

Image Quality Settings - Image Menu 121



Normally the projector automatically detects and optimizes the input signal
settings. If you need to customize the settings, you can use the Signal I/O menu.
The available settings depend on the currently selected input source.

Setting Options Description

Source — Displays settings saved for each input
source.
To change settings for an input source,
make sure the source is connected and
select that source.

Signal Format Video Range Sets the video range to match the setting
of input source.
This setting is displayed only when the
current source is HDMI.

Setting Options Description

Color Space Auto
BT.709
BT.2020

Sets the conversion system for the color
space.
This setting is displayed only when the
current source is HDMI.

Dynamic Range Dynamic Range Changes the range of dark and bright
areas in images; choose from Auto
(recommended), SDR, HDR10, or HLG.
This setting is displayed only when the
current source is HDMI.

Signal Status Displays the detected input image signal.

HDR10 Setting Changes the PQ (Perceptual Quantizer)
curve of the dynamic range using the
HDR PQ method.
This setting is only displayed when
Dynamic Range is set to Auto and the
input signal is HDR10.

HLG Setting Changes the HLG (Hybrid Log Gamma)
curve of the dynamic range using the
HDR HLG method.
This setting is only displayed when
Dynamic Range is set to Auto and Signal
Status is HLG, or when Dynamic Range
is set to HLG.
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Setting Options Description

Image Processing Auto (ALLM)
Fine
Fast

Improves the response speed for images
projected at high speed.
Setting is only displayed when EDID
Mode is set to Up to 4K 60Hz 18Gbps.
• Fine: improves the response speed for

images by selecting Off for Frame
Interpolation.
s Image > Frame Interpolation

• Fast: disables the Frame
Interpolation, Noise Reduction, and
MPEG Noise Reduction settings.
s Image > Frame Interpolation
s Image > Image Enhancement >
Noise Reduction
s Image > Image Enhancement >
MPEG Noise Reduction

Reset to Defaults — Resets all settings for current input
source.

EDID EDID (HDMI1)
EDID (HDMI2)

Describes the display capabilities of
your projector. Change this setting as
necessary according to the resolution of
the image.
You can select the EDID settings
for individual input sources without
changing the input source.

Setting Options Description

HDMI IN EQ Level HDMI1
HDMI2

Adjusts the HDMI input signal level
depending on the devices connected to
the HDMI port. If there is a lot of
interference in the image, or if a problem
such as no image being projected occurs,
change the setting.
You can select the settings for individual
input sources without changing the input
source.

HDMI Link Device
Connections

Lists the devices connected to the HDMI
ports.
Setting is only displayed when HDMI
Link is set to On.

HDMI Link Set to On to enable the HDMI Link
features.

Power On Link Controls what happens when you turn on
the projector or connected device.
• Bidirectional: automatically turns on

the connected device when you turn
on the projector, and vice versa.

• Device -> PJ: automatically turns on
the projector when you turn on the
connected device.

• PJ -> Device: automatically turns on
the connected device when you turn
on the projector.

Power Off Link Controls whether connected devices are
turned off when you turn off the
projector.

Reset Signal I/O
Settings

— Resets all adjustment values on the Signal
I/O menu to their default settings.
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Settings on the Installation menu help you set up your projector in your
installation environment.

Setting Options Description

Fixed Installation On
Off

Set to On if you installed the projector in
a fixed location.

Test Pattern — Displays a test pattern to assist in
focusing and zooming the image and
correcting image shape (press the [Esc]
button to cancel pattern display).

Setting Plate
Installation Guide

— Displays a guide screen when installing
the projector.

Setting Options Description

Projection Front
Rear
Front/Upside
Down
Rear/Upside Down

Sets the way the projector faces the screen
so the image is oriented correctly.

Geometry
Correction

Quick Corner Corrects image shape and alignment
using an on-screen display.

Arc Correction Corrects the corners and sides of an
image projected on a curved surface.

Point Correction Divides the projected image into a grid
and corrects the distortion by moving the
selected point of intersection from side to
side and up and down.

Correct Distortion
Using Smartphone

Corrects the distortion of projected
images using the Epson Setting Assistant
app.

Fit to Screen Using
Smartphone

Corrects the shape and position of images
to fit on your screen using the Epson
Setting Assistant app.

Memory Save customized sets of settings to
memory.
• Save Memory: saves the current shape

of an image you have adjusted.
• Load Memory: loads the settings you

made and saved.
• Rename Memory: changes the name

of the memory settings.
• Erase Memory: deletes a saved

memory.
• Reset Memory: Resets all saved

memories.
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Setting Options Description

Geometry
Correction Wizard

— Guides you step-by-step through
correcting the image shape.

Digital Zoom Various levels
available

Adjusts the size of the projected image.

Image Shift Various positions
available

Shifts the image position horizontally and
vertically.
This feature is not available if the Digital
Zoom option is set to the widest setting.

Remote Receiver Front/Rear
Front
Rear
Off

Limits reception of remote control signals
by the selected receiver; Off turns off all
receivers.

Screen Type 4:3
16:9
16:10

Sets the aspect ratio of the screen to fit
the image into the projection area.
Setting is only displayed when Content
Playback is set to Off in the projector's
Operation menu.

Screen Position Various positions
available

Shifts the image position horizontally and
vertically.
This feature is not available if you set the
Screen Type setting to the same aspect
ratio as the projector resolution.

High Altitude
Mode

On
Off

Regulates the projector’s operating
temperature at altitudes above 1500 m.

Source — Displays settings saved for each input
source.
To change settings for an input source,
make sure the source is connected and
select that source.

Setting Options Description

Blanking Top
Bottom
Left
Right

Hides an area of the projected image that
you select using the arrow buttons.
Setting is only displayed when Content
Playback is set to Off in the projector's
Operation menu.

Reset to Defaults — Resets all settings for current input
source.
Setting is only displayed when Content
Playback is set to Off in the projector's
Operation menu.

Install Again — Opens the wizard to adjust the projected
image when re-installing the projector.

Reset Installation
Settings

— Resets all adjustment values on the
Installation menu to their default
settings, except for the following:
• Digital Zoom
• Image Shift

g Related Links
• "Focusing the Image Using the Focus Lever" p.52
• "Changing the Projection Mode" p.46
• "Projector Setup and Installation Options" p.20
• "Image Shape" p.53
• "Resizing the Image with Digital Zoom" p.62
• "Setting the Screen Type" p.47
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Settings on the Display menu let you customize various projector display
features.

Setting Options Description

No-signal Screen Black
Blue
Logo

Sets the screen color displayed when no
signal is being received.
Setting is only displayed when Content
Playback is set to Off in the projector's
Operation menu.

Startup Screen On
Off

Set to On to display a logo when the
projector starts up.

Home Screen Auto
Disp.

On
Off

Set to On to display the Home screen
automatically when there is no input
signal when turning on the projector.

Setting Options Description

Messages On
Off

Set to On to display messages such as
input source name, color mode name,
aspect ratio, no signal message, or high
temperature warning on your projected
image.

Menu Color Black
White
Logo

Sets the color theme of the Home screen
and projector menu system.

Panel Alignment On
Off

Set to On to correct color misalignment
in the projected image.

Select Color Select the color to correct.

Pattern Color Select the pattern used for correction.

Start Adjustments Starts panel alignment.

Reset Resets all adjustment values on the
Panel Alignment setting to their default
settings.

Reset Display
Settings

— Resets all adjustment values on the
Display menu to their default settings.
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Settings on the Operation menu let you customize various projector features.

Setting Options Description

Auto Source Search On
Off

Set to On to detect the input signal
automatically and project images when
there is no input signal.
This function is disabled when you turn
on the projector in the Quick Startup
mode.
Setting is only displayed when Content
Playback is set to Off.

Setting Options Description

Light Source
Brightness Control

Light Source Mode Select the brightness for the light source.
• Normal: maximum brightness.
• Medium: 75% brightness.
• Quiet: 50% brightness with reduced

fan noise.
• Custom: select a custom brightness

level.

Brightness Level Select the Custom brightness level you
want.

Direct Power On On
Off

Set to On to turn on the projector by
plugging it in without pressing the power
button.

Auto Power On HDMI1
Off

Set to HDMI1 to automatically turn on
the projector when the input signal from
the HDMI1 source is detected.

Power On Trigger Plug-in Detection
Signal Detection

Sets the way the projector turns on when
Auto Power On is set to HDMI1.
Plug-in Detection: Automatically turns
on the projector when it detects that a
connected device has been turned on.
Signal Detection: Automatically turns on
the projector when it detects an HDMI
video signal.
When set to Signal Detection, the
standby power increases. Please consider
the environment before making any
changes.

Sleep Mode On
Off

Set to On to automatically turn off the
projector after an interval of inactivity.

Sleep Mode Timer 1 to 30 minutes Sets the interval for Sleep Mode.
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Setting Options Description

Standby Mode Communication
On
Communication
Off

Set to Communication On to allow
monitoring and controlling the projector
over a network when the projector is in
standby mode.
Setting is only displayed in the following
cases:
• Auto Power On is not set to HDMI1

and Power On Trigger is set to Plug-
in Detection.

• USB Power is set to On While
Projecting.

Startup Source Various input
sources available

Select the image source you want to
project when the projector is turned on
in Content Playback mode.

Quick Startup 20min.
60min.
90min.
Unlimited
Off

Sets the time period for Quick Startup
mode. The projector enters this mode
when you turn it off. You can start
projecting in approximately 5 seconds by
pressing the power button.
However, the projector may take longer
to become ready for use when projecting
from the USB port.
This setting is displayed only when Auto
Power On is set to HDMI1 and Power
On Trigger is set to Plug-in Detection.

USB Power On While
Projecting
Always On

Set to Always On to continue supplying
power to the streaming media player
when the projector is not projecting
images.
This setting is displayed only when Auto
Power On is set to HDMI1 and Power
On Trigger is set to Plug-in Detection.
When set to Always On, the standby
power increases.

Setting Options Description

Indicators On
Off

Set to Off to turn off the indicator lights
on the projector except when an error or
warning occurs.

Inv Direction
Button

On
Off

When suspending the projector from a
ceiling, set to On to invert the operation
direction of the control panel arrow
buttons.

Content Playback On
Off

Set to On to play back a playlist.

Overlay Effect Overlay Effect
Shape Filter
Color Filter
Lightness

Adds color and shape effects to the
projected image.
This setting is displayed only when the
playlist can be played and no writable
error has occurred in Content Playback
mode.

USB Viewer — Selects and plays back a playlist saved on
the USB flash drive.

Reset Operation
Settings

— Resets all adjustment values on the
Operation menu to their default settings.

g Related Links
• "Adjusting the Brightness" p.77
• "Projecting in Content Playback Mode" p.87
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Settings on the Management menu let you customize various projector
administrative features.

Setting Options Description

User Button Various menu
options available

Assigns a menu option to the [User]
button on the remote control for one-
touch access.

Child Lock On
Off

Locks the power button on the projector's
control panel to prevent children from
turning the projector on by accident.
This setting is only displayed when
Control Panel Lock is set to Except for
Power or Off.

Setting Options Description

Control Panel Lock Full Lock
Except for Power
Off

Controls projector button locking to
secure the projector:
• Full Lock: locks all buttons.
• Except for Power: locks all buttons

except the power button.
• Off: no buttons locked.

4K Enhancement On
Off

Projects an image at a doubled
resolution by diagonally shifting 1 pixel
in increments of 0.5 pixels. A high-
resolution image signal is projected in
fine detail.
You cannot select this setting when the
Aspect setting is set to Native in the
projector's Signal I/O menu.

Color Uniformity Color Uniformity Set to On to adjust the color tone balance
for the whole screen.

Adjustment Level Sets the adjustment level.

Start Adjustments Adjusts the red, green, and blue color
tones individually for the selected area.

Reset Resets all adjustment values on the
Color Uniformity menu to their default
settings.

Refresh Mode Timer Sets a time period during which the
projector displays the refresh image.

Messages Set to On to display a message informing
you that the projector is in refresh mode.

Start Starts the refresh mode process to clear
any projected afterimage and turn off the
projector after a specified period of time.
Press any button on the remote control to
cancel this process.
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Setting Options Description

Date & Time Date & Time
Daylight Saving
Time
Internet Time

Adjusts the projector's system time and
date settings. Select Daylight Saving
Time to set daylight saving time settings
for your region. Select Internet Time to
automatically acquire the time from an
Internet time server.

Schedule Settings — Schedules projector events to occur
automatically at selected dates and times.

Log Save
Destination

Internal Memory
USB and Internal
Memory

Sets the location in which to save error
and operation log files.
Setting is only displayed when Content
Playback is set to Off in the projector's
Operation menu.

Batch Setup Range All
Limited

Select All to copy all of the projector
menu settings using the batch setup
feature. Select Limited, if you do not
want to copy the following settings:
• EDID in the Signal I/O menu
• Network menu settings

Language Various languages
available

Select the language for projector menu
and message displays.

Information Various
information

Displays information about the projector
and input sources. The displayed items
vary depending on the current input
source.

Display Status System
Version
Network Wired
Input Signal

Displays the projector's status
information.

Display Logs Temp Warning Info
Power On/Off
History

Displays log data saved to the location
specified in the Log Save Destination
setting.

Setting Options Description

Reset Management
Settings

— Resets all adjustment values on the
Management menu to their default
settings, except for Language.

g Related Links
• "Locking the Projector's Buttons" p.95
• "Setting the Date and Time" p.42
• "Setting Projector Event Schedules" p.114
• "Selecting the Language for the Projector Menus" p.45
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Settings on the Network menu let you view network information and set up the
projector for controlling over a network.

Setting Options Description

Wired LAN Info. Various
information

Displays wired network status and details.

Network Settings — Configures your projector network
settings. See the network menu table for
details on the Network Settings.

Reset Network
Settings

— Resets all adjustment values on the
Network menu to their default settings.

Once you have connected your projector to your network, you can select
projector settings and control projection using a compatible Web browser.
This allows you to access the projector remotely.

g Related Links
• "Network Menu - Network Settings Menu" p.131

Network Menu - Network Settings Menu

Settings on the Network Settings menu let you select the basic network settings.

If no Web Control Password has been set, a screen prompting you to set
a password is displayed before you can save network settings. Follow the
on-screen instructions to set the password.

Setting Options Description

Projector Name Up to 16
alphanumeric
characters
(do not use " *
+ , / : ; < = > ? [ \ ] `
| spaces)

Enter a name to identify the projector
over the network.

Web Control
Password

Up to 32
alphanumeric
characters
(do not use * :
spaces)

Enter a password to use when accessing
the projector over the Web. (The user
name is EPSONWEB. No password is set
by default. If no Web Control Password
has been set, a browser error screen
is displayed. Set the password in the
Network Settings menu.)

Wired LAN — See the Wired LAN menu table for
details.

Projector Control — See the Projector Control menu table for
details.

g Related Links
• "Network Menu - Wired LAN Menu" p.132
• "Network Menu - Projector Control Menu" p.132
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Network Menu - Wired LAN Menu

Settings on the Wired LAN menu let you select the wired LAN settings.

Setting Options Description

IP Settings DHCP
IP Address
Subnet Mask
Gateway Address

Set DHCP to On if your network assigns
addresses automatically; set to Off to
manually enter the network's IP Address,
Subnet Mask, and Gateway Address
using 0 to 255 for each address field.
Do not use these addresses: 0.0.0.0,
127.x.x.x, 192.0.2.x or 224.0.0.0 through
255.255.255.255 (where x is a number
from 0 to 255) for IP Address,
255.255.255.255 or 0.0.0.0 through
254.255.255.255 for Subnet Mask, and
0.0.0.0, 127.x.x.x or 224.0.0.0 through
255.255.255.255 for Gateway Address.

DNS Server 1
DNS Server 2

Various IP
addresses

Enter the IP address for the DNS server,
using 0 to 255 for each address field. The
DNS server resolves the host name. You
cannot use the following IP addresses:
127.x.x.x (where x is a number from 0 to
255).
When these settings are not set
and remain as 0.0.0.0, DNS server
information is acquired using DHCP.
After acquiring the information, the
values remain as 0.0.0.0.

IPv6 On
Off

Set to On if you want to connect the
projector to the network using IPv6.
IPv6 is supported to monitor and control
the projector over a network using Epson
Web Control and PJLink.

Setting Options Description

Auto Configuration On
Off

Set to On to assign addresses
automatically according to the Router
Advertisement.

Use Temporary
Address

On
Off

Set to On if you want to use a temporary
IPv6 address.

IP Address Display On
Off

Set to On to display the IP address on the
network information screen and Home
screen.

Network Menu - Projector Control Menu

Settings on the Projector Control menu let you select settings for controlling
the projector over a network.

Setting Options Description

Command
Communication

Protected
Compatible

Selects the authentication method for
command communication.
When using Command Communication,
set the Monitor Password or the Web
Control Password.
sNetwork > Network Settings > Web
Control Password
Set to Compatible when performing
plain text authentication using the
Monitor Password (up to 16
alphanumeric characters long).
Select Compatible when monitoring
projectors with a switcher and a system
controller.

Web API Settings Web API Select On to enable the Web API
function.
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Setting Options Description

Authentication Selects the security for your projector to
use during Web API communications.
Open: Security is not set.
Digest: Communication is performed
using API authentication (Digest
authentication).
See the Web API Specifications for
Projectors for details.

Basic Control On
Off

Set to On to monitor and control the
projector using Basic Control in Epson
Web Control.
This setting is only displayed when
Content Playback is set to Off in the
projector's Operation menu.

Remote Password Up to 8
alphanumeric
characters
(do not use * :
spaces)

Enter a password to access the
projector using Basic Control in Epson
Web Control. (The user name is
EPSONREMOTE. No password is set by
default.)

PJLink On
Off

Set to On to enable the PJLink
notification function.

PJLink Password Up to 32
alphanumeric
characters
(do not use spaces
and any symbols
other than @)

Enter a password for using the PJLink
protocol for projector control.
You must set the PJLink Password when
using the PJLink function for the first
time.

Setting Options Description

Notified IP Address Various IP
addresses

Enter the IP address to receive the
projector's operating status when the
PJLink notification function is enabled.
Enter the addresses using 0 to 255 for
each address field.
Do not use these addresses: 127.x.x.x or
224.0.0.0 through 255.255.255.255 (where
x is a number from 0 to 255).

AMX Device
Discovery

On
Off

Set to On when you want to allow the
projector to be detected by AMX Device
Discovery.

Crestron
Connected

On
Off

Set to On only when monitoring or
controlling the projector over the network
using Crestron Connected.

Password Up to 20
alphanumeric
characters

Enter a password to enable Crestron
Connected. No password is set by
default.

Crestron XiO
Cloud

On
Off

Set to On to monitor or control your
projector and other devices over the
network using the Crestron XiO Cloud
service.

Control4 SDDP On
Off

Set to On to allow device information
to be acquired using Control4 Simple
Device Discovery Protocol (SDDP).

Secure HTTP On
Off

To strengthen security, communication
between the projector and computer
in Web control is encrypted. When
setting security with Web control, it is
recommended to set this to On.

Web Server
Certificate

— Imports the Web server certificate for
secure HTTP.
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Settings on the Memory menu let you manage saving and loading of image
quality settings in the projector's memory.

Setting Options Description

Save Memory Memory 1 to 10 Saves customized sets of settings to
memory.

Load Memory Memory 1 to 10 Loads saved memory settings and applies
them to the current image.

Rename Memory Memory 1 to 10 Changes the name of the memory
settings.

Erase Memory Memory 1 to 10 Deletes a saved memory.

Reset Memory
Settings

— Resets all saved memories.

g Related Links
• "Saving Settings to Memory and Using Saved Settings " p.94

Image Quality Memory Settings - Memory Menu 134



Settings on the ECO menu let you customize projector functions to save power.

Setting Options Description

Light Source Mode — See the Operation menu table for details
on the Light Source Mode settings.

Sleep Mode — See the Operation menu table for details
on the Sleep Mode settings.

Sleep Mode Timer — See the Operation menu table for details
on the Sleep Mode Timer settings.

Standby Mode — See the Operation menu table for details
on the Standby Mode settings.

g Related Links
• "Projector Feature Settings - Operation Menu" p.127
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Settings on the Initial/All Settings menu let you reset certain projector settings
to their default values and place the projector in firmware update mode so you
can update the firmware.

Setting Options Description

Reset All — Lets you select menus for resetting the
settings to default values.

Firmware Update — Enters the firmware update mode and
ready to update firmware using the USB-
A or USB-B port.

Export Batch
Settings

Yes
No

Exports the projector's menu settings to a
USB flash drive or a computer, allowing
you to copy them to other projectors of
the same model.

Import Batch
Settings

Yes
No

Imports menu settings that have been
saved to a USB flash drive or a computer.

Reset All options
When you select Reset All, you see the following screen.

If you do not want to reset values in particular menus, deselect the check box
next to the menu name. When you are ready to reset setting values, select
Execute.
You cannot reset the following settings:
• Digital Zoom
• Image Shift
• Language

g Related Links
• "Updating the Firmware" p.152
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After selecting the projector's menu settings for one projector, you can use the
following methods to copy the settings to other projectors, as long as they are
the same model.
• by using a USB flash drive
• by connecting a computer and projector using a USB cable
You cannot copy any information unique to an individual projector, such as
Light Source Hours or Status.

• Perform batch setup before adjusting the image settings such as
keystone distortion correction. Since image adjustment values are
also copied to another projector, the adjustments you made before
performing the batch setup are overwritten and the projected screen
you adjusted may change.

• Make sure Batch Setup Range is set to Limited if you do not want to
copy the following settings:
• EDID in the Signal I/O menu
• Network menu settings
sManagement > Batch Setup Range

Caution
Epson takes no responsibility for batch setup failures and associated repair costs due
to power outages, communication errors, or other problems that may cause such
failures.

g Related Links
• "Transferring Settings From a USB Flash Drive" p.137
• "Transferring Settings From a Computer" p.138

Transferring Settings From a USB Flash Drive

You can copy menu settings from one projector to another of the same model
using a USB flash drive.

• The USB flash drive must use a FAT 16/32 format and not incorporate
any security function. Delete any files on the drive before using it for
batch setup or the settings may not be saved correctly.

• You can also use this batch setup method from the projector's menu.

a Disconnect the power cord from the projector, and check that all of the
projector's indicators have turned off.

b Connect an empty USB flash drive directly to the projector's USB-A port.

c Hold down the [Esc] button on the remote control or the control panel
and connect the power cord to the projector.

d When all of the projector's indicators turn on, release the [Esc] button.
The indicators start flashing and the batch setup file is written to the USB
flash drive. When writing is finished, the projector turns off.

Caution
Do not disconnect the power cord or the USB flash drive from the projector
while the file is being written. If the power cord or USB flash drive is
disconnected, the projector may not start correctly.
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e Remove the USB flash drive.

The file name for the batch setup file is PJCONFDATA.bin. If you
need to change the file name, add text after PJCONFDATA using
only alphanumeric characters. If you change the PJCONFDATA
section of the file name, the projector may not be able to recognize
the file correctly.

f Disconnect the power cord from the projector to which you want to copy
settings, and check that all of the projector's indicators have turned off.

g Connect the USB flash drive containing the saved batch setup file to the
projector's USB-A port.

h Hold down the [Menu] button on the remote control or the control panel
and connect the power cord to the projector.

i When all of the projector's indicators turn on, release the [Menu] button.
(The indicators remain on for approximately 75 seconds.)
When all of the indicators start flashing, the settings are being written.
When writing is finished, the projector turns off.

Caution
Do not disconnect the power cord or the USB flash drive from the projector
while the file is being written. If the power cord or USB flash drive is
disconnected, the projector may not start correctly.

j Remove the USB flash drive.

Transferring Settings From a Computer

You can copy menu settings from one projector to another of the same model by
connecting the computer and projector with a USB cable.

• You can use this batch setup method with the following operating
system versions:
• Windows 10 and later
• macOS 10.13.x and later

• You can also use this batch setup method from the projector's menu.

a Disconnect the power cord from the projector, and check that all of the
projector's indicators have turned off.

b Connect a USB cable to the computer's USB port and to the projector's
USB-B port.

c Hold down the [Esc] button on the remote control or the control panel
and connect the power cord to the projector.

d When all of the projector's indicators turn on, release the [Esc] button.
The computer recognizes the projector as a removable disk.

e Open the removable disk icon or folder, and save the batch setup file to the
computer.

The file name for the batch setup file is PJCONFDATA.bin. If you
need to change the file name, add text after PJCONFDATA using
only alphanumeric characters. If you change the PJCONFDATA
section of the file name, the projector may not be able to recognize
the file correctly.
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f Eject the USB device (Windows) or drag the removable disk icon to the
Trash (Mac).

g Disconnect the USB cable.
The projector turns off.

h Disconnect the power cord from the projector to which you want to copy
settings, and check that all of the projector's indicators have turned off.

i Connect the USB cable to the computer's USB port and to the projector's
USB-B port.

j Hold down the [Menu] button on the remote control or the control panel
and connect the power cord to the projector.

k When all of the projector's indicators turn on, release the [Menu] button.
The computer recognizes the projector as a removable disk.

l Copy the batch setup file (PJCONFDATA.bin) that you saved to your
computer to the top level folder of the removable disk.

Do not copy any files or folders other than the batch setup file to the
removable disk.

m Eject the USB device (Windows) or drag the removable disk icon to the
Trash (Mac).

n Disconnect the USB cable.
When all of the indicators start flashing, the settings are being written.
When writing is finished, the projector turns off.

Caution
Do not disconnect the power cord from the projector while the file is being
written. If the power cord is disconnected, the projector may not start
correctly.

g Related Links
• "Batch Setup Error Notification" p.139

Batch Setup Error Notification

The status indicator on the projector notifies you if an error occurs during
a batch setup operation. Check the status of the indicator and follow the
instructions in this table.

Indicator status Problem and solutions

Orange - flashing fast The batch setup file may be corrupt, or the USB flash
drive may not be connected correctly.
Disconnect the USB flash drive, unplug and then plug in
the projector's power cord, and then try again.
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Maintaining the Projector

Follow the instructions in these sections to maintain your projector.

g Related Links
• "Projector Maintenance" p.141
• "Cleaning the Projection Window" p.142
• "Cleaning the Obstacle Sensor" p.143
• "Cleaning the Projector Case" p.144
• "Air Filter and Vent Maintenance" p.145
• "Adjusting the Color Convergence (Panel Alignment)" p.150
• "Updating the Firmware" p.152



You may need to clean the projection window and obstacle sensor periodically,
and clean the air filter and air vents to prevent the projector from overheating
due to blocked ventilation.
The only parts you should replace are the air filter and remote control batteries.
If any other part needs replacing, contact Epson or an authorized Epson
servicer.

Warning
Before cleaning any part of the projector, turn it off and unplug the power cord.
Never open any cover on the projector, except as specifically explained in this
manual. Dangerous electrical voltages in the projector can injure you severely.
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Clean the projection window periodically, or whenever you notice dust or
smudges on the surface.
• To remove dust or smudges, gently wipe the projection window with clean

and dry lens-cleaning paper.
• If the projection window is dusty, blow off dust using a blower, and then wipe

the projection window.

Warning
• Before cleaning the projection window, turn off the projector and unplug the

power cord.
• Do not use any flammable gas sprays such as air dusters to blow off dust. The

high heat generated by the projector may cause a fire.

Attention
• Do not wipe the projection window right after you turn off the projector. Doing

so could damage the projection window.
• Do not use any harsh materials to clean the projection window and do not

subject the projection window to any impacts; otherwise, it could be damaged.
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Clean the projector's obstacle sensor glass periodically, or if you see a message
telling you to remove any obstacles that are interfering with the projection area.
To remove dust or smudges, gently wipe the sensors with lens-cleaning paper.

Warning
Do not use a lens cleaner that contains flammable gas to clean the obstacle sensor.
The high heat generated by the projector may cause a fire.

Attention
Do not use glass cleaner or any harsh materials to clean the obstacle sensor and do
not subject the obstacle sensor to any impacts. Damage on the surface of the sensor
may cause malfunctions.
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Before cleaning the projector case, turn off the projector and unplug the power
cord.
• To remove dust or dirt, use a soft, dry, lint-free cloth.
• To remove stubborn dirt, use a soft cloth moistened with water and mild

soap. Do not spray liquid directly on the projector.

Attention
Do not use wax, alcohol, benzene, paint thinner, or other chemicals to clean the
projector case. These can damage the case. Do not use canned air, or the gases
may leave a flammable residue.
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Regular filter maintenance is important to maintain your projector. Clean
the air filter when a message appears telling you the temperature inside the
projector has reached a high level. It is recommended that you clean these
parts over a 20,000 hour period. Clean them more often than this if you use
the projector in an environment that is dustier than expected. (Assuming the
projector is used in an atmosphere in which airborne particulate matter is less
than 0.04 to 0.2 mg/m3.)

Attention
If regular maintenance is not performed, your Epson projector will notify you when
the temperature inside the projector has reached a high level. Do not wait until this
warning appears to maintain your projector filter as prolonged exposure to high
temperatures may reduce the life of your projector.

g Related Links
• "Cleaning the Air Filter " p.145
• "Replacing the Air Filter" p.147
• "Cleaning the Air Intake Vents " p.149

Cleaning the Air Filter

You need to clean the projector's air filters in the following situations:
• The filter get dusty.
• You see a message telling you to clean it.

a Turn off the projector and unplug the power cord.

b Carefully remove the front cover fixing points on the left and right side of
the cover.

c Remove the front cover.
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d Slide the air filter cover latch and pull out the air filter cover.

e Pull the air filter out of the air filter cover.

f Vacuum the front of the air filter (the side with the tabs) to remove any
remaining dust.

Attention
• Do not rinse the air filter in water, or use any detergent or solvent to clean

it.
• Do not use canned air. The gases may leave a flammable residue or push

dust and debris into the projector's optics or other sensitive areas.

g Place the air filter with the four tabs facing down as shown.

Attention
Do not force the air filter cover to close with the tabs on the air filter facing up.
Doing so could damage the projector.

h Insert the air filter cover until it clicks into place.
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i Replace the front cover.

Replacing the Air Filter

You need to replace the air filter in the following situations:
• After cleaning the air filter, you see a message telling you to clean or replace it.
• The air filter is torn or damaged.
You can replace the air filter while the projector is mounted to the ceiling or
placed on a table.

a Turn off the projector and unplug the power cord.

b Carefully remove the front cover fixing points on the left and right side of
the cover.

c Remove the front cover.
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d Slide the air filter cover latch and pull out the air filter cover.

e Pull the air filter out of the projector.

Dispose of used air filters according to local regulations.
• Filter frame: Polypropylene
• Filter: Polypropylene, PET

f Place the new air filter with the four tabs facing down as shown.

Attention
Do not force the air filter cover to close with the tabs on the air filter facing up.
Doing so could damage the projector.

g Insert the air filter cover until it clicks into place.

h Replace the front cover.
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Cleaning the Air Intake Vents

Clean the projector's air intake vents periodically, or whenever you notice dust
on the surface of the vents to prevent the projector from overheating due to
blocked ventilation.

a Turn off the projector and unplug the power cord.

b Turn the projector upside down.

c Carefully remove the dust using a vacuum cleaner or a brush.
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You can use the Panel Alignment feature to manually adjust the color
convergence (the alignment of the red and blue colors) in the projected image.
You can adjust the pixels horizontally and vertically in increments of 0.125
pixels within a range of ± 3 pixels.

• You can adjust only the red or blue color convergence. Green is the
standard color panel and cannot be adjusted.

• Image quality may decline after performing Panel Alignment.
• Images for pixels that extend beyond the edge of the projected screen

are not displayed.

a Press the [Menu] button, select the Display menu, and then press [Enter].

b Select Panel Alignment and press [Enter].

c Select Panel Alignment and set it to On.

d Select Select Color and choose one of the following:
• R to adjust the red color convergence.
• B to adjust the blue color convergence.

e Select Pattern Color and choose the grid color displayed when making
adjustments. The available color varies depending on the Select Color
setting.
• R/G/B to display the grid color in white.
• R/G to display the grid color in yellow.
• G/B to display the grid color in cyan.

f Select Start Adjustments and press [Enter].
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g Select one of the following options:
• Select Shift the whole panel to adjust the entire panel at the same time

and go to the next step.
• Select Adjust the four corners to adjust the corners of the panel one at

a time and go to step 10.

h Use the arrow buttons on the remote control to adjust the color alignment
selected in Select Color, and then press [Enter].

Adjustment affects the grid lines in the entire screen.

i Select one of the following options:
• Select Adjust the four corners to fine-tune your adjustments.
• Select Exit to finish adjustments.

j Use the arrow buttons on the remote control to adjust the color alignment
of the screen corner highlighted by the orange box, and then press [Enter].

k When you are finished adjusting each corner of the screen, press [Enter].

l Select one of the following options:
• If your projector needs additional panel alignment, select Select

intersection and adjust. Use the arrow buttons on the remote control
to highlight the corner of any misaligned box on the screen, press
[Enter], make any necessary adjustments, and then press [Enter] again.
Repeat this step as necessary for the other intersections.

• Select Exit to finish adjustments.
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When you select the Firmware Update option in the projector's Initial/All
Settings menu, the projector enters firmware update mode and is ready to
perform a firmware update using the USB-A or USB-B port.

g Related Links
• "Updating Firmware Using a USB Storage Device" p.152
• "Updating Firmware Using a Computer and USB Cable" p.153

Updating Firmware Using a USB Storage Device

You can update the projector's firmware using a USB storage device.

Responsibility for updating the firmware lies with the customer. If a
firmware update fails due to problems such as a power failure or
communication problems, a fee will be charged for any necessary repairs.

a Download the projector firmware file from the Epson Web site.

b Copy the downloaded firmware file to the root folder (highest folder in the
hierarchy) of the USB storage device.

• The USB storage device must be formatted in FAT format.
• Do not copy any other files to the USB storage device.
• Do not change the firmware's file name. If the file name is

changed, the firmware update will not start.
• Check that the firmware file you copied is the correct file for your

projector model. If the firmware file is not correct, the firmware
update will not start.

c Connect the USB storage device to the projector's USB-A port.

Connect the USB storage device directly to the projector. If the USB
storage device is connected using a USB hub, the firmware update
may not be applied correctly.

d Press the [Menu] button, select the Initial/All Settings menu, and press
[Enter].

e Select Firmware Update and press [Enter].
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f Select Yes to start the firmware update.

• Do not disconnect the power cord from the projector while the
firmware is updating. If the power cord is disconnected, the
projector may not start correctly.

• Do not disconnect the USB storage device from the projector
while the firmware is updating. If the USB storage device is
disconnected, the update may not be applied correctly.

All of the projector's indicators start flashing and the firmware update
starts. When the update finishes normally, the projector enters standby
status (only the power indicator is lit blue). If Direct Power On is set to
On in the projector's Operation menu, the projector turns back on again.

When the update finishes, check the Information menu in the projector's
Management menu to make sure that the Version information has been
updated to the correct firmware version.

When all indicators flash rapidly, the firmware update may have failed.
Disconnect the power cord from the projector, and then reconnect it to
the projector. If the indicators continue to flash even after reconnecting
the power cord, remove the power plug from the electrical outlet and
contact Epson.

Updating Firmware Using a Computer and USB Cable

You can update the projector's firmware using a computer and a USB cable.

• Responsibility for updating the firmware lies with the customer. If
a firmware update fails due to problems such as a power failure or
communication problems, a fee will be charged for any necessary
repairs.

• Your computer must be running one of the following operating systems
to update the firmware.
• Windows 10 or later
• macOS 10.13.x or later

a Download the projector firmware file from the Epson Web site.

• Do not change the firmware's file name. If the file name is
changed, the firmware update will not start.

• Check that the firmware file you copied is the correct file for your
projector model. If the firmware file is not correct, the firmware
update will not start.

b Connect the USB cable to the computer's USB port and to the projector's
USB-B port.
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c Press the [Menu] button, select the Initial/All Settings menu, and press
[Enter].

d Select Firmware Update and press [Enter].

e Select Yes to start the firmware update.

Do not disconnect the power cord from the projector while the
firmware is updating. If the power cord is disconnected, the
projector may not start correctly.

All of the projector's indicators turn on and the projector enters firmware
update mode. The computer recognizes the projector as a removable disk.

f On the computer, copy the firmware file to the root folder (highest folder
in the hierarchy) of the removable disk.

• Do not copy any other files or folders to the removable disk.
Otherwise, the files or folders may be lost.

• The projector turns off automatically if the USB cable or the
power cord are disconnected before the firmware file can be
copied to the removable disk. If this occurs, perform the
procedure again.

g Perform the steps to safely remove a USB device from the computer and
disconnect the USB cable from the projector.
All of the projector's indicators start flashing and the firmware update
starts. When the update finishes normally, the projector enters standby
status (only the power indicator is lit blue). If Direct Power On is set to
On in the projector's Operation menu, the projector turns back on again.

When the update finishes, check the Information menu in the projector's
Management menu to make sure that the Version information has been
updated to the correct firmware version.

• When all indicators flash rapidly, the firmware update may have failed.
Disconnect the power cord from the projector, and then reconnect it to
the projector. If the indicators continue to flash even after reconnecting
the power cord, remove the power plug from the electrical outlet and
contact Epson.

• If no operations are performed for 20 minutes in update mode, the
projector turns off automatically. If this occurs, perform the procedure
again.

Updating the Firmware 154



Solving Problems

Check the solutions in these sections if you have any problems using the projector.

g Related Links
• "Projection Problems" p.156
• "Projector Indicator Status" p.157
• "Solving Image or Sound Problems" p.159
• "Solving Projector or Remote Control Operation Problems" p.165
• "Solutions to Problems in Content Playback Mode" p.167
• "Solving Network Problems" p.168
• "Solutions When HDMI Link does not Function" p.169



If the projector is not working properly, turn it off, unplug it, and then plug it
back in and turn it on.
If this does not solve the problem, check the following:
• The indicators on the projector may indicate the problem.
• The solutions in this manual can help you solve many problems.
If none of these solutions help, contact Epson for technical support.
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The status indicator on the projector displays its current status and notifies you
if an error occurs. Check the status and color of the indicator, and then see the
table for a solution.

When the Indicators setting is set to Off in the projector's Operation
menu, the indicator is off under normal projection conditions.

A Status indicator

Indicator and status Problem and solutions

Lit blue Normal operation.

Flashing blue Warming up, shutting down, or cooling down.
When warming up, wait about 30 seconds for an image to
appear.
All buttons are disabled during warm-up, shutting down,
and cooling down.

Refresh Mode is in progress.
sManagement > Refresh Mode

Indicator and status Problem and solutions

Preparing for monitoring or quick startup mode. All
features are disabled.

Off Standby, sleep mode, or monitoring.
When you press the power button, projection starts.

Flashing orange Laser has a problem.
Turn the projector off, unplug it, and contact Epson for
help.

A fan or sensor has a problem.
Turn the projector off, unplug it, and contact Epson for
help.

Internal projector error
Turn the projector off, unplug it, and contact Epson for
help.

Lit orange Projector has overheated and turned off. Leave it turned
off to cool down for 5 minutes.
• Make sure that the vents and air filter are not clogged

with dust or obstructed by nearby objects.
• Make sure the environmental temperature is not too

hot.
• Clean or replace the air filter.
• If operating the projector at high altitude, set the

High Altitude Mode setting to On in the projector's
Installation menu.

• If the problem persists, unplug the projector and
contact Epson for help.

Laser warning
Turn the projector off, unplug it, and contact Epson for
help.
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Indicator and status Problem and solutions

Low air flow through the air filter or the projector.
• Make sure that the vents and air filter are not clogged

with dust or obstructed by nearby objects.
• Clean or replace the air filter.
• If the problem persists, unplug the projector and

contact Epson for help.

g Related Links
• "Projector Administration Settings - Management Menu" p.129
• "Cleaning the Air Filter " p.145
• "Replacing the Air Filter" p.147
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Check the solutions in these sections if you have any problems with projected
images or sound.

g Related Links
• "Solutions When No Image Appears" p.159
• "Solutions When "No Signal" Message Appears" p.160
• "Solutions When "Not Supported" Message Appears" p.160
• "Solutions When Only a Partial Image Appears" p.161
• "Solutions When the Image is not Rectangular" p.161
• "Solutions When the Image Contains Noise or Static" p.162
• "Solutions When the Image is Fuzzy or Blurry" p.162
• "Solutions When the Image Brightness or Colors are Incorrect" p.163
• "Solutions When an Afterimage Remains on the Projected Image" p.163
• "Solutions to Sound Problems" p.163
• "Solutions When Image and Sound are not in Sync" p.163
• "Solutions When Image File Names are not Displayed Correctly in PC Free"

p.164
• "Solutions When You Cannot Project Images Using the PC Free Feature"

p.164

Solutions When No Image Appears

If no image appears, try the following solutions:
• Press the [Blank] button on the remote control to see if the image was

temporarily turned off.
• Make sure all necessary cables are securely connected and the power is on for

the projector and connected video sources.
• Connect the video source directly to the projector.
• If you are projecting from a streaming media player, make sure it is powered

by the power supply USB cable on the projector.
• Make sure the connected device meets the HDMI CEC standard. See the

documentation supplied with the device for more information.

• If you are projecting from a laptop computer, make sure it is set up to display
on an external monitor.

• Press the projector's power button to wake it from standby or sleep mode.
Also, check if the connected computer is in sleep mode or displaying a blank
screen saver.

• If the projector does not respond when you press the control panel buttons,
the buttons may be locked for security. Unlock the buttons from the Control
Panel Lock or Child Lock setting in the projector's Management menu, or
use the remote control to turn on the projector.

• If the projector does not respond when you press any buttons on the
projector, an internal error may have occurred in the projector. Contact
Epson for help.

• Adjust the Brightness setting in the projector's Image menu for individual
image colors.

• Adjust the brightness of your projector's light source.
sOperation > Light Source Brightness Control

• Make sure the Messages setting is set to On in the projector's Display menu.
• The projector may not be able to project copyrighted videos that you play

back on a computer. For more details, see the manual supplied with the
computer.

• For images projected with Windows Media Center, reduce the screen size
from full screen mode.

• For images projected from applications using Windows DirectX, turn off
DirectX functions.

g Related Links
• "Unlocking the Projector's Buttons" p.96
• "Projector Administration Settings - Management Menu" p.129
• "Input Signal Settings - Signal I/O Menu" p.122
• "Image Quality Settings - Image Menu" p.120
• "Projector Feature Settings - Operation Menu" p.127
• "Projector Display Settings - Display Menu" p.126
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Solutions When "No Signal" Message Appears

If the No Signal message appears, try the following solutions:
• Press the [Source] button on the control panel and wait a few seconds for an

image to appear.
• Turn on the connected computer or video source, and press play to begin

your presentation, if necessary.
• Check that all cables required for projection are securely connected.
• If you are projecting from a laptop computer, make sure it is set up to display

on an external monitor.
• If necessary, turn off the projector and the connected computer or video

source, and then turn them back on.
• Set the CEC function for the connected device again and restart the device.
• If you are projecting from an HDMI source, replace the HDMI cable with the

shorter one.
• If the other solutions do not solve the problem, reset all of the projector

settings using Reset All on the Initial/All Settings menu.

g Related Links
• "Displaying From a Windows Laptop" p.160
• "Displaying From a Mac Laptop" p.160

Displaying From a Windows Laptop

If the message No Signal is displayed when projecting from a laptop, you need
to set up the Windows laptop to display on an external monitor.

a Hold down the Windows key and press P on your keyboard at the same
time, then click Duplicate.

b If the same image is not displayed by the laptop and projector, check
the Windows Display utility to make sure the external monitor port is
enabled and extended desktop mode is disabled.

c If necessary, check your video card settings and set the multiple display
option to Mirror or Duplicate.

Displaying From a Mac Laptop

If the message No Signal is displayed when projecting from a Mac laptop, you
need to set up the laptop for mirrored display. (See your laptop manual for
details.)

a Open the System Preferences utility and select Displays.

b Select the Display or Color LCD option, if necessary.

c Click the Arrange or Arrangement tab.

d Select Mirror Displays.

Solutions When "Not Supported" Message Appears

If the message Not supported is displayed, try the following solutions:
• Make sure the correct input signal is selected in the projector's Signal I/O

menu.
• Make sure the computer's display resolution does not exceed the projector's

resolution and frequency limits. If necessary, select a different display
resolution for your computer.
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• If you are projecting from an HDMI source, change the HDMI IN EQ Level
setting in the projector's Signal I/O menu. After changing the setting, you
may need to restart the projector. Follow the on-screen instructions.

• If you are projecting using a thumb-sized media streaming device, set the
HDMI IN EQ Level setting to Auto in the projector's Signal I/O menu. If a
problem occurs, change the setting.

g Related Links
• "Input Signal Settings - Signal I/O Menu" p.122
• "Supported Monitor Display Resolutions" p.173

Solutions When Only a Partial Image Appears

If only a partial computer image appears, try the following solutions:
• Make sure you selected the correct Screen Type setting in the projector's

Installation menu for the screen you are using.
If there are margins between the edge of the image and the projected screen
frame, adjust the position of the image.

• If you have adjusted the image size using the Digital Zoom setting in the
projector's Installation menu, perform Image Shift to adjust the image
position.
s Installation > Digital Zoom > Image Shift

• Press the [Aspect] button on the remote control to select a different image
aspect ratio.

• Check your computer display settings to disable dual display and set the
resolution within the projector's limits.

• Check the resolution assigned to your presentation files to see if they are
created for a different resolution.

• When projecting in Content Playback mode, make sure you are using the
appropriate Overlay Effect settings.
sOperation > Content Playback > Overlay Effect

• Make sure you selected the correct Projection setting in the projector's
Installation menu.

g Related Links
• "Projector Installation Settings - Installation Menu" p.124
• "Adjusting the Image Position Using Screen Position" p.48
• "Image Quality Settings - Image Menu" p.120
• "Supported Monitor Display Resolutions" p.173
• "Adding Effects to Your Projected Image" p.90

Solutions When the Image is not Rectangular

If the projected image is not evenly rectangular, try the following solutions:
• Place the projector directly in front of the center of the screen, facing it

squarely, if possible.
• Adjust the Quick Corner setting to correct the image shape.
s Installation > Geometry Correction > Quick Corner

• Adjust the Arc Correction setting to correct the image shape projected on a
curved surface.
s Installation > Geometry Correction > Arc Correction

• Adjust the Point Correction setting to correct slight distortion which occurs
partially.
s Installation > Geometry Correction > Point Correction

g Related Links
• "Correcting the Image Shape with Quick Corner" p.54
• "Correcting Image Shape with Arc Correction" p.57
• "Correcting Image Shape with Point Correction" p.59
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Solutions When the Image Contains Noise or Static

If the projected image contains electronic interference (noise) or static, try the
following solutions:
• Check the cables connecting your computer or video source to the projector.

They should be:
• Separated from the power cord to prevent interference
• Securely connected at both ends
• Not connected to an extension cable

• Adjust the Noise Reduction and MPEG Noise Reduction settings in the
projector's Image menu.
s Image > Image Enhancement > Noise Reduction
s Image > Image Enhancement > MPEG Noise Reduction

• Select a computer video resolution and refresh rate that are compatible with
the projector.

• If you adjusted the image shape using the projector controls, try decreasing
the Sharpness setting in the projector's Image menu to improve image
quality.

• If you connected an extension power cable, try projecting without it to see if
it caused interference in the signal.

• Make sure you selected the correct EDID setting in the projector's Signal I/O
menu, if available for your image source.

• Change the HDMI IN EQ Level setting in the projector's Signal I/O menu.

If you connected an A/V system that does not support eARC/ARC to the
HDMI2 (eARC/ARC) port, the image may be distorted.

g Related Links
• "Image Quality Settings - Image Menu" p.120
• "Supported Monitor Display Resolutions" p.173

• "Input Signal Settings - Signal I/O Menu" p.122

Solutions When the Image is Fuzzy or Blurry

If the projected image is fuzzy or blurry, try the following solutions:
• Display a test pattern and use it to adjust the image focus using the focus

lever.
• Position the projector close enough to the screen.
• Position the projector so the keystone adjustment angle is not so wide that it

distorts the image.
• Clean the projection window.

To avoid condensation on the lens after bringing the projector in from
a cold environment, let the projector warm up to room temperature
before using it.

• Adjust the Sharpness setting in the projector's Image menu to improve image
quality.

• If you are projecting from a computer, use a lower resolution or select a
resolution that matches the projector's native resolution.

g Related Links
• "Focusing the Image Using the Focus Lever" p.52
• "Cleaning the Projection Window" p.142
• "Image Quality Settings - Image Menu" p.120
• "Input Signal Settings - Signal I/O Menu" p.122
• "Supported Monitor Display Resolutions" p.173
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Solutions When the Image Brightness or Colors are
Incorrect

If the projected image is too dark or light, or the colors are incorrect, try the
following solutions:
• Press the [Color Mode] button on the remote control to try different color

modes for the image and environment.
• Check your video source settings.
• Adjust the available settings in the projector's Image menu for the current

input source, such as Brightness, Contrast, Tint, Color Saturation, and
RGBCMY.

• Make sure you selected the correct Dynamic Range setting in the projector's
Signal I/O menu.

• Make sure you selected the correct Signal Format or EDID setting in the
projector's Signal I/O menu, if available for your image source.

• Make sure all the cables are securely connected to the projector and your
video device. If you connected long cables, try connecting shorter cables.

• Position the projector close enough to the screen.

g Related Links
• "Adjusting Image Quality (Color Mode)" p.68
• "Image Quality Settings - Image Menu" p.120
• "Input Signal Settings - Signal I/O Menu" p.122
• "Projector Administration Settings - Management Menu" p.129

Solutions When an Afterimage Remains on the
Projected Image

If you see an afterimage in the projected image, use the Refresh Mode feature to
clear it. Select Refresh Mode > Start in the projector's Management menu.

g Related Links
• "Projector Administration Settings - Management Menu" p.129

Solutions to Sound Problems

If there is no sound or the volume is too low or high, try the following solutions:
• Check the cable connections between the projector and your video/audio

source.
• Check your video/audio source to make sure the volume is turned up and the

audio output is set for the correct source.
• If you are using an eARC/ARC-compatible A/V system, check the following

items:
• Make sure your A/V system is connected to the projector's eARC/ARC

compatible HDMI port. See the Supplemental A/V Support Specification for
eARC/ARC audio supported formats.

• Make sure the cable meets the HDMI CEC standard.
• Make sure the connected A/V system meets the HDMI CEC standard. See

the documentation supplied with the device for more information.

g Related Links
• "Projector Connections" p.28
• "Input Signal Settings - Signal I/O Menu" p.122

Solutions When Image and Sound are not in Sync

If there is no sound or the volume is too low or high, try the following solutions:
• When Image Processing is set to Fine in the projector's Signal I/O menu, set

Frame Interpolation to Off in the projector's Image menu.
• Set Image Processing to Fast in the projector's Signal I/O menu.
• Select the sound output settings of the video devices connected to the

projector. For details, see the documentation supplied with your video device.
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Solutions When Image File Names are not Displayed
Correctly in PC Free

If any file names are longer than the display area or include unsupported
symbols, the file names are shortened or changed in PC Free. Shorten or change
the file name.

Solutions When You Cannot Project Images Using the
PC Free Feature

If you are using a USB device with a slow transfer speed, you may not be able to
project movies correctly.
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Check the solutions in these sections if you have problems operating the
projector or remote control.

g Related Links
• "Solutions to Projector Power or Shut-Off Problems" p.165
• "Solutions to Problems with the Remote Control" p.165
• "Solutions to Password Problems" p.166
• "Solution When "The Battery that Saves Your Clock Settings is Running Low"

Message Appears" p.166

Solutions to Projector Power or Shut-Off Problems

If the projector does not turn on when you press the power button or it turns off
unexpectedly, try the following solutions:
• Make sure the power cord is securely connected to the projector and to a

working electrical outlet.
• If the power button on the remote control does not turn on the projector,

check its batteries and make sure at least one of the remote receivers are
available in the Remote Receiver setting in the projector's Installation menu.

• The projector's buttons may be locked for security. Unlock the buttons
from the Control Panel Lock or Child Lock setting in the projector's
Management menu, or use the remote control to turn on the projector.

• If the projector's light source turns off unexpectedly, it may have entered
sleep mode after a period of inactivity. Perform any operation to wake the
projector. To turn off sleep mode, set the Sleep Mode setting to Off in the
projector's Operation menu.

• If the projector's light source turns off and the status indicator is lit, the
projector has overheated and turned off.

• The cooling fans may run in standby status depending on the projector
settings. Also, when the projector wakes from standby status, the fans may
cause an unexpected noise. This is not a malfunction.

• The power cord may be defective. Disconnect the cord and contact Epson for
help.

g Related Links
• "Unlocking the Projector's Buttons" p.96
• "Projector Administration Settings - Management Menu" p.129
• "Projector Feature Settings - Operation Menu" p.127
• "Projector Installation Settings - Installation Menu" p.124

Solutions to Problems with the Remote Control

If the projector does not respond to remote control commands, try the following
solutions:
• Check that the remote control batteries are installed correctly and have

power. If necessary, replace the batteries.
• Make sure you are operating the remote control within the reception angle

and range of the projector.
• Make sure the projector is not warming up or shutting down.
• Check to see if a button on the remote control is stuck down, causing it to

enter sleep mode. Release the button to wake the remote control up.
• Strong fluorescent lighting, direct sunlight, or infrared device signals may be

interfering with the projector's remote receivers. Dim the lights or move the
projector away from the sun or interfering equipment.

• Make sure at least one of the remote receivers are available in the Remote
Receiver setting in the projector's Installation menu.

• If the Remote Receiver setting is disabled, hold down the [Menu] button on
the remote control for at least 15 seconds to reset the setting to its default.

• If you lose the remote control, you can order another one from Epson.

g Related Links
• "Installing Batteries in the Remote Control" p.35
• "Remote Control Operation" p.36
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• "Projector Installation Settings - Installation Menu" p.124

Solutions to Password Problems

If you cannot enter or remember a password, try the following solutions:
• If you have entered an incorrect password too many times and see a message

displaying a request code, write down the code and contact Epson for help.
Provide the request code and proof of ownership for assistance in unlocking
the projector.

• If you lose the remote control you cannot enter a password. Order a new one
from Epson.

Solution When "The Battery that Saves Your Clock
Settings is Running Low" Message Appears

If the message The battery that saves your clock settings is running low. is
displayed, contact Epson for help.
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If you cannot play back a playlist correctly, try the following solutions:
• Make sure Content Playback is set to On.
sOperation > Content Playback

• Make sure the USB flash drive contains a playlist.
• Make sure the USB flash drive is directly connected to the projector. Do not

use a multi-card reader or a USB hub to expand a USB port.
• If the USB flash drive is partitioned, you may not be able to play back

playlists. Delete all of the partitions before saving the playlists on the USB
flash drive.

• Do not share a playlist between projectors that are different in resolution.
Color and shape effects added by using Overlay Effect may not be
reproduced correctly.
sOperation > Content Playback > Overlay Effect

g Related Links
• "Projector Feature Settings - Operation Menu" p.127
• "Getting the Latest Version of the Documents" p.8
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Check the solutions in these sections if you have problems using the projector
on a network.

g Related Links
• "Solutions When You Cannot Access the Projector Through the Web" p.168

Solutions When You Cannot Access the Projector
Through the Web

If you are unable to access the projector through a Web browser, make sure you
are using the correct ID and password.
• Make sure you use the following user IDs. (You cannot change the user IDs.)

• To access the Basic Control option, enter EPSONREMOTE.
• To access other options and save settings, enter EPSONWEB.

• For the infrastructure mode, make sure you have access to the network the
projector is on.

• If your Web browser is set up to connect via a proxy server, the Epson Web
Control screen cannot be displayed. Make settings for a connection without
using a proxy server.

• If you set the Standby Mode setting to Communication On in the projector's
Operation menu, make sure the network device is turned on. After turning
on the network device, turn on the projector.

The user ID and password are case sensitive.

g Related Links
• "Network Menu - Network Settings Menu" p.131
• "Projector Feature Settings - Operation Menu" p.127
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If you cannot operate the connected devices using the HDMI Link features, try
the following solutions:
• Make sure the cable meets the HDMI CEC standard.
• Check if the device is available in the Device Connections list. If the device

does not appear in the Device Connections list, it does not meet the HDMI
CEC standards. Connect a different device.
s Signal I/O > HDMI Link > Device Connections

• Check that all cables required for HDMI Link are securely connected.
• Make sure the connected devices are turned on and in standby status. See the

documentation supplied with the device for more information.
• If you connect a new device or change the connection, set the CEC function

for the connected device again and restart the device.

g Related Links
• "Input Signal Settings - Signal I/O Menu" p.122
• "HDMI Link Features" p.80
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Appendix

Check these sections for the technical specifications and important notices about your product.

g Related Links
• "Optional Accessories and Replacement Parts" p.171
• "Screen Size and Projection Distance" p.172
• "Supported Monitor Display Resolutions" p.173
• "Projector Specifications" p.174
• "External Dimensions" p.175
• "Supported Features for Epson Projector Content Manager" p.176
• "List of Safety Symbols and Instructions" p.177
• "Laser Safety Information" p.179
• "Glossary" p.182
• "Notices" p.184



The following optional accessories and replacement parts are available. Please
purchase these products as and when needed.
The following list of optional accessories and replacement parts is current as of:
October 2024.
Details of accessories are subject to change without notice and availability may
vary depending on the country of purchase.

g Related Links
• "Screens" p.171
• "Mounts" p.171
• "External Devices" p.171
• "Replacement Parts" p.171

Screens

Ultra Short Throw Screen ELPSC35 (100")
Ultra Short Throw Screen ELPSC36 (120")

Screens to be installed on a wall. (Aspect ratio 16:9)

Mounts

Setting plate ELPMB75
Use when installing the projector on a wall.

Ceiling mount ELPMB22
Ceiling mount (Low profile) ELPMB30

Use when installing the projector on a ceiling.
Safety Wire Set ELPWR01

Use when connecting the projector to the installation mount to prevent the
projector from falling down.

Ceiling pipe (450 mm) ELPFP13
Ceiling pipe (700 mm) ELPFP14

Use when installing the projector on a high ceiling.

Special expertise is required to suspend the projector from a ceiling.
Contact Epson for help.

External Devices

Android TV™ device ELPAP12
Use this streaming media player to watch online content.

Replacement Parts

Air filter ELPAF64
Use as a replacement for used air filters.
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Check the table here to determine how far to place the projector from the screen
based on the size of the projected image.

A Projection distance (cm)

B Distance from the back of the projector to the screen (cm)

C Distance from the projector to the bottom of the screen (cm)

D Distance from the projector to the top of the screen (cm)

E Distance from the center of the lens to the rear of the projector (cm)

16:9 screen size A B C D

Wide

80" 177 × 100 27.8 2.3 10.8 110.4

90" 199 × 112 31.6 6 12.8 124.9

100" 221 × 125 35.3 9.8 14.9 139.4

110" 244 × 137 39 13.5 16.9 153.9

120" 266 × 149 42.8 17.3 19 168.4

140" 310 × 174 50.3 24.7 23 197.4

16:9 screen size A B C D

Wide

160" 354 × 199 57.8 32.2 27.1 226.4

4:3 screen size A B C D

Wide

66" 134 × 101 28.1 2.6 11 111.6

70" 142 × 107 29.9 4.4 12 118.7

80" 163 × 122 34.5 9 14.5 136.4

90" 183 × 137 39.1 13.6 17 154.1

100" 203 × 152 43.7 18.1 19.5 171.9

120" 244 × 183 52.8 27.3 24.4 207.3

130" 264 × 198 57.4 31.9 26.9 225.1

16:10 screen size A B C D

Wide

74" 159 × 100 27.8 2.3 10.8 110.4

80" 172 × 108 30.2 4.7 12.1 119.8

90" 194 × 121 34.3 8.8 14.3 135.5

100" 215 × 135 38.3 12.8 16.5 151.2

110" 237 × 148 42.4 16.9 18.7 166.8

120" 259 × 162 46.4 20.9 21 182.5

130" 280 × 175 50.5 24.9 23.2 198.2

148" 319 × 199 57.8 32.2 27.1 226.4
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See the Specifications for detailed information on compatible refresh rates and
resolutions for each compatible video display format.
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Product name EH-QS100B/EH-QS100W

Dimensions 695 (W) × 145 (H) × 341 (D) mm (not including raised
section)

LCD panel size 0.62"

Display method 3LCD

Number of pixels Full HD (1,920 (W) × 1,080 (H) dots) × 3

Screen resolution 4,147,200 pixels *

Focus adjustment Manual

Light source Laser diode

Light source output
power

Up to 126 W

Wavelength 449 to 461 mm

Laser class Class 4

Light source life ** Up to about 20,000 hours

Speaker N/A

Power supply 100-240V AC±10% 50/60Hz 4.0 - 1.8 A

Power consumption (100
to 120 V area)

Operating power consumption: 346 W

Power consumption (220
to 240 V area)

Operating power consumption: 333 W

Standby power
consumption

Communication On: 2.0 W
Communication Off: 0.4 W

Operating altitude Altitude 0 to 3,048 m

Operating temperature Altitude of 0 to 2,286 m: 0 to +40°C (Humidity of 20 to
80%, No condensation)
Altitude of 2,287 to 3,048 m: 0 to +35°C (Humidity of 20
to 80%, No condensation)

Storage temperature -10 to +60°C (Humidity of 10 to 90%, No condensation)

Mass Approx. 12.0 kg

* Pixel shifting technology achieves 4K resolution on screen.
** Approximate time until the light source brightness decreases to half of its
original value. (Assuming the projector is used in an atmosphere in which
airborne particulate matter is less than 0.04 to 0.2mg/m3. The estimated time
varies depending on the projector usage and operating conditions.)
This product is also designed for IT power distribution system with phase-to-
phase voltage 230V.
The rating label is attached on the bottom of the projector.

Angle of tilt
There is no vertical or horizontal limit to how the projector can be installed.

g Related Links
• "Connector Specifications" p.174

Connector Specifications

HDMI port 2 HDMI (Audio is only supported by
PCM)

RS-232C port 1 Mini D-Sub 9-pin (male)

USB-A port 2 USB connector (Type A)

USB-B port 1 USB connector (Type B)

LAN port 1 RJ-45

• USB ports are not guaranteed to operate all devices that support USB.
• USB-B port does not support USB 1.1.
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A Center of the projection window

The unit in these illustrations is mm.
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Your projector supports the following features and options of the Epson
Projector Content Manager software.

Features/Options EH-QS100B/EH-QS100W

Simultaneous playback -

Save the playlist to the projector via a network ✓

Settings > Video Format Auto Select ✓

AVI Format ✓

MP4 Format ✓
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The following table lists the meaning of the safety symbols labeled on the
equipment.

No. Symbol mark Approved
standards

Description

A IEC60417
No. 5007

"ON" (power)
To indicate connection to the mains.

B IEC60417
No. 5008

"OFF" (power)
To indicate disconnection from the
mains.

C IEC60417
No. 5009

Stand-by
To identify the switch or switch
position by means of which part of the
equipment is switched on in order to
bring it into the stand-by condition.

D ISO7000
No. 0434B,
IEC3864-B3.1

Caution
To identify general caution when using
the product.

E IEC60417
No. 5041

Caution, hot surface
To indicate that the marked item can
be hot and should not be touched
without taking care.

F IEC60417
No. 6042
ISO3864-B3.6

Caution, risk of electric shock
To identify equipment that has risk of
electric shock.

G IEC60417
No. 5957

For indoor use only
To identify electrical equipment
designed primarily for indoor use.

No. Symbol mark Approved
standards

Description

H IEC60417
No. 5926

Polarity of d.c. power connector
To identify the positive and negative
connections (the polarity) on a piece
of equipment to which a d.c. power
supply may be connected.

I — The same as No. 8.

J IEC60417
No. 5001B

Battery, general
On battery powered equipment. To
identify a device for instance a cover
for the battery compartment, or the
connector terminals.

K IEC60417
No. 5002

Positioning of cell
To identify the battery holder itself and
to identify the positioning of the cell(s)
inside the battery holder.

L — The same as No. 11.

M IEC60417
No. 5019

Protective earth
To identify any terminal which is
intended for connection to an external
conductor for protection against
electric shock in case of a fault, or the
terminal of a protective earth electrode.

N IEC60417
No. 5017

Earth
To identify an earth (ground) terminal
in cases where neither the symbol No.
13 is explicitly required.
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No. Symbol mark Approved
standards

Description

O IEC60417
No. 5032

Alternating current
To indicate on the rating plate that the
equipment is suitable for alternating
current only; to identify relevant
terminals.

P IEC60417
No. 5031

Direct current
To indicate on the rating plate that the
equipment is suitable for direct current
only; to identify relevant terminals.

Q IEC60417
No. 5172

Class II equipment
To identify equipment meeting the
safety requirements specified for Class
II equipment according to IEC 61140.

R ISO 3864 General prohibition
To identify actions or operations that
are prohibited.

S ISO 3864 Contact prohibition
To indicate injury that could occur
due to touching a specific part of the
equipment.

T — Never look into the optical lens while
the projector is on.

U — To indicate that the marked item don’t
place anything on projector.

V ISO3864
IEC60825-1

Caution, laser radiation
To indicate the equipment has a laser
radiation part.

No. Symbol mark Approved
standards

Description

W ISO 3864 Disassembly prohibition
To indicate a risk of injury, such as
electric shock, if the equipment is
disassembled.

X IEC60417
No. 5266

Standby, partial standby
To indicate that part of the equipment
is in the ready status.

Y ISO3864
IEC60417
No. 5057

Caution, movable parts
To indicate that you must keep away
from movable parts according to
protection standards.

Z IEC60417
No. 6056

Caution (Moving Fan Blades)
As a safety precaution, stay away from
the moving fan blades.

a IEC60417
No. 6043

Caution (Sharp Corners)
To indicate sharp corners that should
not be touched.

b — To indicate that looking into the lens
while projecting is prohibited.

c ISO7010
No. W027
ISO 3864

Warning, Optical radiation (such as
UV, visible radiation, IR)
Taking care to avoid injury to eyes and
skin when in the vicinity of optical
radiation.

d IEC60417
No. 5109

Not to be used in residential areas.
To identify electrical equipment which
is not suitable for a residential area.
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This projector is a Class 1 laser product that complies with the IEC60825-1:2014
and EN60825-1:2014 + A11:2021international standards for lasers.
Follow these safety instructions when using the projector.

Warning
• Do not open the projector's case. The projector contains a high-powered laser.
• Possibly hazardous optical radiation emitted from this product. Do not look at

operating light source. Eye injury may result.

Caution
Do not disassemble the projector when disposing of it. Dispose according to your
local or national laws and regulations.

The projector uses a laser as the light source. The laser has the following
characteristics.
• Depending on the surroundings, the brightness of the light source may

decline. The brightness declines a lot when the temperature gets too
high.

• The brightness of the light source declines the longer it is used. You can
change the relationship between usage time and decline in brightness
settings.

g Related Links
• "Laser Warning Labels" p.179

Laser Warning Labels

Laser warning labels are attached on the projector.

Inside

Top
As with any bright source, do not stare into the beam, RG2 IEC/EN
62471-5:2015.
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Warning
• Never look into the projector lens when the laser is on. This can damage your eyes

and is especially dangerous for children and pets.
• When turning on the projector at a distance using the remote control, make sure

no one is looking into the lens.
• Do not allow small children to operate the projector. Children must be

accompanied by an adult.
• Do not look into the lens during projection. Also, do not look into the lens using

optical devices, such as a magnifying glass or telescope. This could cause visual
impairment.

Bottom

This projector is a consumer Class 1 laser product that complies with
EN50689:2021 standard.
This product projects images onto walls, screens, and so on.
The label attached on the projector varies depending on the countries and
regions.

For North/South America
This projector is a Class 1 laser product that complies with the IEC/
EN60825-1:2014 international standard for lasers. Follow these safety
instructions when using the projector.
Complies with FDA performance standards for laser products except for
conformance as a Risk Group 2 LIP as defined in IEC 62471-5: Ed. 1.0. For
more information see Laser Notice No. 57, dated May 8, 2019.

Rating Labels (EH-QS100W, EH-QS100B)
The rating label contains the certification and identification information for the
projector.
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This section briefly explains the difficult terms that are not explained in the text
of this guide. For details, refer to other commercially available publications.

AMX Device
Discovery

AMX Device Discovery is a technology developed by AMX to
facilitate AMX control systems for easy operation of the target
equipment.
Epson have implemented this protocol technology, and have
provided a setting to enable the protocol function (ON).
See the AMX Web site for more details.
URL http://www.amx.com/

Aspect Ratio The ratio between an image's length and its height.
Screens with a horizontal:vertical ratio of 16:9, such as HDTV
screens, are known as wide screens.
SDTV and general computer displays have an aspect ratio of 4:3.

Contrast The relative brightness of the light and dark areas of an image
can be increased or decreased to make text and graphics stand
out more clearly, or to make them appear softer. Adjusting this
particular property of an image is called contrast adjustment.

DHCP An abbreviation of Dynamic Host Configuration Protocol, this
protocol automatically assigns an IP address to equipment
connected to a network.

Full HD A screen size standard with a resolution of 1,920 (horizontal) ×
1,080 (vertical) dots.

Gateway Address This is a server (router) for communicating across a network
(subnet) divided according to subnet mask.

HDCP HDCP is an abbreviation for High-bandwidth Digital Content
Protection.
It is used to prevent illegal copying and protect copyrights by
encrypting digital signals sent over DVI and HDMI ports.
Because the HDMI port on this projector supports HDCP, it can
project digital images protected by HDCP technology.
However, the projector may not be able to project images
protected with updated or revised versions of HDCP encryption.

HDMI™ An abbreviation for High Definition Multimedia Interface.
HDMI™ is a standard aimed at digital consumer electronics
and computers. This is the standard by which HD images and
multichannel audio signals are digitally transmitted.
By not compressing the digital signal, the image can be
transferred at the highest quality possible. It also provides an
encryption function for the digital signal.

HDTV An abbreviation for High-Definition Television that refers to
high-definition systems which satisfy the following conditions:
• Vertical resolution of 720p or 1080i or greater (p =

Progressive, i = Interlace)
• Screen aspect ratio of 16:9

Interlace Transmits information needed to create one screen by sending
every other line, starting from the top of the image and working
down to the bottom.
Images are more likely to flicker because one frame is displayed
every other line.

IP Address A number to identify a computer connected to a network.

Progressive Projects information to create one screen at a time, displaying
the image for one frame.
Even though the number of scan lines is the same, the amount
of flicker in images decreases because the volume of information
has doubled compared with an interlace system.

Refresh Rate The light-emitting element of a display maintains the same
luminosity and color for an extremely short time.
Because of this, the image must be scanned many times per
second to refresh the light-emitting element.
The number of refresh operations per second is called the
Refresh rate and is expressed in hertz (Hz).

SDTV An abbreviation for Standard Definition Television that refers to
standard television systems which do not satisfy the conditions
for HDTV High-Definition Television.
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sRGB An international standard for color intervals that was formulated
so that colors that are reproduced by video equipment can be
handled easily by computer operating systems (OS) and the
Internet. If the connected source has an sRGB mode, set both
the projector and the connected signal source to sRGB.

Subnet Mask This is a numerical value that defines the number of bits used for
the network address on a divided network (subnet) from the IP
address.

WUXGA A screen size standard with a resolution of 1,920 (horizontal) ×
1,200 (vertical) dots.
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Check these sections for important notices about your projector.
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FCC Compliance Statement

Supplier's DECLARATION of CONFORMITY
According to 47CFR, Part 2 and 15
Class B Personal Computers and Peripherals; and/or
CPU Boards and Power Supplies used with Class B Personal Computers

We: Epson America, Inc.
Located at: 3131 Katella Avenue, Los Alamitos, CA
Tel: 562-981-3840
Declare under sole responsibility that the product identified herein, complies
with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each
product marketed, is identical to the representative unit tested and found to
be compliant with the standards. Records maintained continue to reflect the
equipment being produced can be expected to be within the variation accepted,
due to quantity production and testing on a statistical basis as required by
47CFR 2.906. Operation is subject to the following two conditions: (1) this
device may not cause harmful interference, and (2) this device must accept

any interference received, including interference that may cause undesired
operation.
Trade Name: EPSON
Type of Product: LCD Projector
Model: HB49A
Options:

Product name Model

Remote controller 2232830 xx (x=0-9)

FCC Compliance Statement For United States Users
This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference,
and (2) this device must accept any interference received, including interference
that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause interference to radio and television reception, which can
be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures.
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
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WARNING
The connection of a non-shielded equipment interface cable to this equipment
will invalidate the FCC Certification or Declaration of this device and may
cause interference levels which exceed the limits established by the FCC for
this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than
one interface connector, do not leave cables connected to unused interfaces.
Changes or modifications not expressly approved by the manufacturer could
void the user's authority to operate the equipment.

For Canadian Users

Indication of the manufacturer and the importer in
accordance with requirements of EU directive

Manufacturer: SEIKO EPSON CORPORATION
Address: 3-5, Owa 3-chome, Suwa-shi, Nagano-ken 392-8502 Japan
Telephone: 81-266-52-3131
http://www.epson.com/

Importer: EPSON EUROPE B.V.
Address: Atlas Arena, Asia Building, Hoogoorddreef 5,1101 BA Amsterdam Zuidoost
The Netherlands
Telephone: 31-20-314-5000
http://www.epson.eu/

Indication of the manufacturer and the importer in
accordance with requirements of United Kingdom
directive

Manufacturer: SEIKO EPSON CORPORATION
Address: 3-5, Owa 3-chome, Suwa-shi, Nagano-ken 392-8502 Japan
Telephone: 81-266-52-3131
http://www.epson.com/

Importer: Epson (UK) Ltd.
Address: Westside, London Road, Hemel Hempstead, Hertfordshire, HP3 9TD,
United Kingdom
http://www.epson.co.uk

Restriction of Use

When this product is used for applications requiring high reliability/safety
such as transportation devices related to aviation, rail, marine, automotive etc.;
disaster prevention devices; various safety devices etc; or functional/precision
devices etc, you should use this product only after giving consideration to
including fail-safes and redundancies into your design to maintain safety
and total system reliability. Because this product was not intended for use
in applications requiring extremely high reliability/safety such as aerospace
equipment, main communication equipment, nuclear power control equipment,
or medical equipment related to direct medical care etc, please make your own
judgment on this product’s suitability after a full evaluation.

Operating System References

• Microsoft ® Windows® 8.1 operating system
• Microsoft ® Windows® 10 operating system
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• Microsoft ® Windows® 11 operating system
In this guide, the operating systems above are referred to as "Windows 8.1",
"Windows 10", and "Windows 11". Furthermore, the collective term "Windows"
is used to refer to them all.
• macOS 10.13.x
• macOS 10.14.x
• macOS 10.15.x
• macOS 11.0.x
• macOS 12.0.x
In this guide, the operating systems above are referred to as "macOS 10.13.x",
"macOS 10.14.x", "macOS 10.15.x", "macOS 11.0.x", and "macOS 12.0.x".
Furthermore, the collective term "Mac" is used to refer to them all.

Trademarks

EPSON is a registered trademark of Seiko Epson Corporation.
Mac and macOS are trademarks of Apple Inc.
Microsoft, Windows, and the Windows logo are trademarks or registered
trademarks of Microsoft Corporation in the United States and/or other
countries.
App Store is a service mark of Apple Inc.
Chrome is a trademark of Google LLC.
HDMI, the HDMI Logo and High-Definition Multimedia Interface are
trademarks or registered trademarks of HDMI Licensing Administrator, Inc.

"QR Code" is a registered trademark of DENSO WAVE INCORPORATED.
PJLink trademark is a trademark applied for registration or is already registered
in Japan, the United States of America and other countries and areas.

Crestron®, Crestron Connected®, Crestron Fusion®, Crestron RoomView®, and
Crestron XiO Cloud® are registered trademarks of Crestron Electronics, Inc.

Adobe and Adobe Reader are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other countries.
Other product names used herein are also for identification purposes only and
may be trademarks of their respective owners. Epson disclaims any and all
rights in those marks.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in
a retrieval system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written
permission of Seiko Epson Corporation. No patent liability is assumed with
respect to the use of the information contained herein. Neither is any liability
assumed for damages resulting from the use of the information contained
herein.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser
of this product or third parties for damages, losses, costs, or expenses incurred
by the purchaser or third parties as a result of: accident, misuse, or abuse of this
product or unauthorized modifications, repairs, or alterations to this product,
or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's
operating and maintenance instructions.
Seiko Epson Corporation shall not be liable against any damages or problems
arising from the use of any options or any consumable products other than
those designated as Original Epson Products or Epson Approved Products by
Seiko Epson Corporation.
The contents of this guide may be changed or updated without further notice.
Illustrations in this guide and the actual projector may differ.

Copyright Attribution

This information is subject to change without notice.
© 2024 Seiko Epson Corporation
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